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NTS SERVER HARDWARE LIMITED WARRANTY

THIS IS TO CERTIFY that the NexPath NTS Server hardware ("NTS Server") is hereby warranted to be free of all defects
in material and workmanship for one (1) year from the date of initial purchase from an authorized dealer, but not withstand-
ing this, no longer than 18 months after the date of original manufacture. This Warranty does not apply to a defect caused
by negligence, misuse, accidents, acts of God, or to any use not in accordance with the instructions and specifications pub-
lished by NexPath Corporation ("NexPath"). Use of the NTS Server in emergency or time-critical or medical applications
is not appropriate. This Warranty only applies to hardware; NTS Server software is covered by separate warranty described
in Software License Agreement provided with the system.

During the period of this Warranty, NexPath will repair or replace at our service center located in Santa Clara, California,
any part proving defective in material or workmanship. All expenses related to replacing or repairing a defective part under
this Warranty will be assumed by NexPath except for (a) the cost of transporting the product to NexPath's service center,
which shall be the responsibility of the buyer; and (b) if the NTS Server is not returned in original packaging, then a charge
will be assessed for an approved shipping container.

The buyer must notify NexPath of any defect, malfunction or nonconformity promptly upon discovery. Within 30 days after
receiving the NTS Server from the buyer, NexPath will repair or replace the defective part, at its own option, provided that
NexPath has found the NTS Server to be defective. CUSTOMER'S SOLE AND EXCLUSIVE REMEDY HEREUNDER
SHALL BE LIMITED TO THE REPAIR OR REPLACEMENT SPECIFIED HEREIN.

The foregoing warranties are contingent upon (1) the proper use of the hardware in accordance with the instructions and
specifications published by NexPath, (2) the purchase of the NTS Server from a dealer or distributor authorized by Nex-
Path to sell the NTS Server, and (3) return of a properly completed Warranty Registration Card within 30 days of purchase;
and may not apply to any NTS Server that has been repaired or modified by persons other than NexPath. The NTS Server
Limited Warranty is non-transferable.

BUYER AGREES THAT ITS EXCLUSIVE REMEDIES, AND NEXPATH'S ENTIRE LIABILITY WITH RESPECT
TO THE NTS SERVER, SHALL BE AS SET FORTH HEREIN. BUYER FURTHER AGREES THAT NEXPATH
SHALL NOT BE LIABLE TO BUYER OR ANY THIRD PARTY FOR ANY DAMAGES, INCLUDING ANY LOST
PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF
BUYER'S USE OR INABILITY TO USE THE NTS SERVER OR THE BREACH OF ANY EXPRESS OR IMPLIED
WARRANTY, EVEN IF THE BUYER HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES.

THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER WARRAN-
TIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANT-
ABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

NexPath Corporation
3074 Kenneth Street
Santa Clara, CA 95054

This Warranty is effective only if the enclosed registration card is returned to NexPath within thirty (30) days of the date
of initial purchase. NexPath neither assumes nor authorizes any representative or other person to assume for NexPath any
other liability in connection with the sale or shipment of NexPath products.
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CHAPTER 1 Introduction
Welcome to the NexPath Telephony Server! The NexPath Telephony Server is a complete integrated tele-
phone system, including switching (or PBX-type functions), voice mail, automated attendant, automated call
distribution (or ACD), and network access and administration. This unique solution to small company tele-
phone systems allows you to have most if not all of the features of a large company PBX at a fraction of the
cost of these larger systems.

In fact, in many ways the NexPath Telephony Server goes beyond the functionality of most traditional tele-
phone systems. The NexPath Telephony Server was the first web-enabled telephone system when it was
introduced in late 1996. It has unique features not commonly found on larger systems, such as allowing you
to perform functions like picking up a ringing phone from any other phone, checking and retrieving your
voice mail from any desktop computer in the building or on the Internet, ring groups within call distribution
groups, and many other features that are unique to NexPath.

Note This manual, along with all other system manuals, is available on the NexPath Telephony Server in
Adobe Acrobat format, if your PC is connected to the LAN. The URL for the list of manuals is http://
<system name>/manuals/1. Other URLs that are useful are available on the NexPath Telephony Server
at the URL http://<system name>/ or http://<system name>/help/.

1. Replace <system name> with the name assigned your specific NexPath Telephony Server by your system administrator, or
the IP address assigned to the NexPath Telephony Server. If you use the IP address, you must put in the trailing “/”.
1
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The NexPath Telephony Server combines the following subsystems into a single, tightly integrated, easy-to-
install, easy-to-maintain package:

• A complete switching system (PBX-like functions)

• Up to 136-line (outside+inside lines) capability.

• Functions such as call routing and switching can be performed using standard touch-tone codes
from conventional telephones. No expensive, proprietary phones are necessary.

• High bandwidth (64 kilobits per second), all digital signal paths pass fax and modem signals trans-
parently.

• Automatic fax detection

• An auto-attendant system

• Allows automated answering and routing of calls.

• Fully configurable, including custom messages and flexible numbering plans.

• Multiple auto-attendants with a different auto-attendant on each line if desired.

• A voice message recording and retrieval (i.e., voice mail) system

• Over 50 hours of voice mail and custom messages can be stored per system.

• Password protection provided for all voice mail access.

• Personal greetings can be recorded for each extension.

• 64 kilobits-per-second digitization, storage, and playback gives your messages unsurpassed clarity.

• 30 port simultaneous voice mail access capability.

• Support of the VMWI (FSK) voice mail waiting light.

• An Automatic Call Distribution (ACD) system

• Allows calls to be directed to a group, such as sales, rather than just to an individual.

• Multiple overlapping distribution groups with priority settings.

• Custom reassurance messages and hold music while the caller is waiting in the hold queue.

Other features include:

• Integrated TCP/IP LAN for network control and administration

• System administration is performed using standard Web browser (Netscape or Internet Explorer)
software running on any desktop computer.

• Control of any extension can be performed either from a telephone, from the Windows programs
NexDial™ or NexDirector™, or from a Mozilla or Netscape Web browser software running on
2
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any desktop computer.

• Complete backup via LAN command, and retrieval of the backup file via ftp.

• A completely open network API (NexPath Simple Computer Telephony Protocol, N-SCTP) for
custom application development and 1st and 3rd party call control.

• Voice prompts and error messages available for all telephone operations

• A public address output for announcements, speaker ringing, and background music.

• A music-on-hold input

• Multiple auto-attendants and ACD groups can be set up

• Call waiting and call forwarding

• A complete system activity log

• Ring groups, including ring groups in ACD groups

• Distinctive ringing

• Reminder rings

• Multiple hold stack

• Park orbits

• Call recording

• Barge-in to voice mail in progress

• Listen-in to voice mail in progress

• Caller-ID pass-through and decoding (inside and outside calls).

• Visual Call Waiting (waiting call Caller ID).

• Power-failure bypass relays on all CO lines

• Multiple extension number assignment capability per line

• Numeric page upon receipt of voice mail

• System speed dial numbers

• Email notification upon receipt of voice mail.

• Announce name (screening) of calls based on Caller ID.

• Distintive Ringing for inside verses outside calls.

• Call routing based on multiple caller ID tables.
3
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Where to go for assistance

Every company has its own way of handling support for the NexPath System. Most have a person that is
responsible for the setup and administration of the NexPath Telephony Server, for making configuration
changes and answering questions about use of the telephone system. This person, the system administrator,
can provide you with information on use of the features of the system, and help you troubleshoot problems if
they arise.

All manuals on the system can be viewed from your web browser, if your system is LAN connected. The
URL is: http://<system_IP_address>/, then click on the link Manuals. Fill in <system_IP_address> with
the IP address provided to you by your system administrator. Note that in all URLs you must enter the trail-
ing “/” unless your system administrator has assigned the system a name that you can use instead of the IP
address.

In addition to this manual, the User’s Guide, there is also the System Administration Guide, and any Release
Notes provided with your system when it was shipped. All of these are also available on-line at the URL
listed above.

You can also have your system administrator call NexPath Support. The telephone number is on the Nex-
Path web page: http://www.nexpath.com.

Support Policies

NexPath provides telephone support for a single contact person (the system administrator) at no charge for a
limited period of time (usually 90 days) after the purchase of the system. Extended telephone support and
software upgrade services are also available for an annual charge. Check with your system administrator.
Please relay any questions you cannot resolve to your system administrator.
4
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Legal Notices

WARNING: The NexPath Telephony Server can be programmed to allow users, if the feature is enabled by
the system administrator and a valid password is entered, to listen in to or record conversations without the
participants knowledge. Listening in to or recording a conversation without the consent of one or both par-
ties may be a violation of local, state, and federal privacy laws. It is the responsibility of the user of the Nex-
Path Telephony Server, when using features of the system, to assure that he or she is in compliance with all
applicable laws.

WARNING: The NexPath Telephony Server includes a LAN based protocol, NexPath Simple Computer
Telephony Protocol (N-SCTP), that allows the system to be programmed to function as an Automatic Dial
and Announce Device (ADAD). ADADs or similar devices that are used for commercial solicitation, or used
without the consent of the called party, are prohibited by many local, state, and federal laws. It is the
responsibility of the user of the NexPath Telephony Server, when using features of the system, to assure that
he or she is in compliance with all applicable laws.
5
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CHAPTER 2 Telephone Operations
The NexPath Telephony Server allows operations such as placing calls on hold, transferring a call, and set-
ting up conference calls to be controlled from any telephone connected to the system. This chapter describes
the operations available and how to control them. Note, though, that all of the operations described in this
chapter can also be performed from a Windows 95/98/NT/2K/XP computer if the computer is connected to
the NexPath Telephony Server through a TCP/IP network connection, and the program NexDial™ is
installed. Some operations are also available from NexDirector™. Also, Windows and non-Windows
machines connected to the network and running Netscape 4 or Mozilla 5 or later versions can run
TelOper™, a web-based desktop call control program. See CHAPTER 4:Windows Desktop Tools- Nex-
Dial™ starting on page 67 and CHAPTER 5:Windows Desktop Tools- NexPath Call Director starting on
page 97 for details.

Also, all voice mail operations can be performed from either a telephone or a computer. However, the key
sequences described in this chapter for call control from a telephone will be unavailable while you are
actively retrieving voice mail from a telephone. For details on voice mail operation, see CHAPTER 3:Voice
Mail starting on page 51.
7
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General Concepts

Below is a list of topics which are common to the commands described throughout the rest of this chapter.
Please take the time to read this information before proceeding to the actual commands available in the Nex-
Path Telephony Server.

Hook-flashes

Hook-flashes are one of the more complicated operations needed in the NexPath Telephony Server. The rea-
son we need them, though, is that if you press the keys on your telephone keypad while in the middle of a
normal call, the NexPath Telephony Server simply passes these key presses on to the other party. This is
handy when the other party’s phone system can do something with them, such as route your call to an exten-
sion within their building, but it makes it difficult to signal the NexPath Telephony Server that you want to
do something special like put a call on hold once you are in the middle of a call.

Some telephone systems solve this problem by requiring that you use special keys on their proprietary
phones (sometimes misleadingly called digital phones). The problems with special phones are that they are
expensive, they only work on one system, they become obsolete quickly, and they often do not have other-
wise commonly available features such as speed-dial.

On the NexPath Telephony Server, you can signal the system that you want to do something special like put
a call on hold while in the middle of a call by performing a hook-flash, then entering the command sequence
for the operation desired. Hook-flashes are done by quickly depressing and releasing the hook switch1 on
your phone, or by pressing the flash key on your phone.

Note, though, that perfecting the art of performing hook-flashes using the hook-switch might take a little
practice. You must depress the switch for long enough to make it obvious to the system that you want to sig-
nal it but not so long that the system thinks you hung up. A valid hook-flash is accomplished by depressing
the telephone hook switch for an interval of greater than 50 milliseconds and less than 1000 milliseconds (a
millisecond is 1/1000ths of a second, so 1000 milliseconds is one second).

Some phones come with a button which performs the hook-flash function. Nortel telephones label it
the Link key. Care must be used with some telephones that have this button, however, since they can issue a

1. The hook-switch is the switch that gets depressed by the handset when you hang up your phone.

Flash
8
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hook-flash for a full 3/4 of a second, which is a fairly long time. Some telephone do not properly collect the
keys you enter during this flash interval. If you begin entering other keys of a sequence before the pre-pro-
grammed flash time has ended, many older phones will block the subsequent tones, and the NexPath Tele-
phony Server will not “hear” these other keys and you will likely get an error message.

Test the telephones you are using, and, if the telephone does not queue the keys, make sure you have waited
until the preprogrammed flash time is over before pressing other keys. Or, better yet, if you have one of
these older phones, learn how to depress and release the hook-switch properly by hand instead of using the

key1.

Note Many telephones are now being produced that properly queue other keypad keys after the flash key, so
that it can be depressed along with the other keys at any rate. In particular, the flash key on the Nortel
9316 (the flash key is called Link on the Nortel phone) and the Panasonic KX-TSC50 or KS-TSC55
telephones works properly with the NexPath Telephony Server.

In this manual, we will designate a hook-flash with the symbol .

Beeps and rings

You will hear one short beep in your conversation if you are on the phone and you leave another call on hold
for too long2. You can use the Swap Hold sequence (i.e., performing a hook-flash followed by
pressing the button on your telephone) to toggle between your existing call and the call on hold.

Note If you are not on the phone and you leave a call on hold too long, you will receive a short ring on your
phone, but when you pick up the phone, no one will be there. You can retrieve this call from hold using
the Retrieve Call From Hold sequence .

1. If you program a sequence into a phone with speed-dial, and is programmed as one of the keys in the pro-
grammed sequence, the phone will automatically wait until the end of its own flash time before issuing the other keys in
the sequence. Therefore, this 3/4 second blanking time is not a problem for flash sequences programmed into a speed-
dialer.

2. This delay time is usually 45 seconds. However, the reminder ring delay time can be changed by your system administra-
tor, and might be set differently for your system.

Flash

Flash

Flash

Flash *
*

* 1
9
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Two short beeps in your conversation indicates that you have a call waiting. You can put the current call on
hold and pick up the new call using the Pick up Waiting Call sequence . You can then use the
Swap Hold sequence to toggle between the two. Note that if you are done with your current call,
you can still use to pick up the incoming call. The pre-existing call you put on hold with the

will disappear when the person you were talking to hangs up.

You will hear three short beeps if you are on the phone and someone uses the barge-in sequence to break into
your conversation.

Table 1: Rings

Sound Meaning
Single normal ring (repeated
every 5 seconds)

By default, an Internal or External call. Your system administrator can
assign different ring cadences to outside calls if you wish.

Short ring every 60 seconds A Reminder ring, meaning a call is on hold or in a park orbit
Double ring, short-long ring, or
other combinations

An Internal or External call, depending on how your extension is config-
ured. Check with your system administrator for different ring cadences.

Table 2: Tones

Sound Meaning
Busy Tone An outside or inside line is in use.
Dial Tone You can make a call or access a feature.
One short beep every 45 seconds A call is on hold or in a park orbit.
Two short beeps A waiting call is trying your extension.
Three short beeps Someone is barging in to your call.
Several short tones followed by dial tone when picking up
telephone.

You have unread voice mail messages.

Flash 3
Flash *

Flash 3
Flash 3
10
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Ring Cadence

Each inside line extension in the NexPath Telephony Server can be programmed to ring with one of six dif-
ferent ring cadences, or ringing patterns:

1. Long ring

2. Medium ring

3. Two short rings

4. Three short rings

5. Long and short ring

6. Short and long ring

Also, each inside line extension can be programmed to ring differently depending on whether the call is an
inside call or an outside call, using these ring cadences. Check with your system administrator if you would
like to have different ring cadences for inside or outside calls at your extension.

Call distribution groups

Your system administrator may configure your system’s auto-attendant to support call distribution groups
(ACD or automated call distribution), that is, groups of extensions which represent entire departments, such
as Sales or Marketing. When a caller calls in, they are given a message such as “Press 1 for Sales, 2 for tech-
nical support...”

When the caller presses one of these selections, the call is routed to the call distribution group defined for the
selection, and each extension within the call distribution that is accepting calls (see Accept Calls on page 14)
will ring in sequence. The exact ring sequence for the group and what happens if no one picks up the call is
determined by the system administrator when the call distribution group is configured.

Ring groups and Pickup groups

Your system administrator can assign a ring group number to any group of physical telephone lines. This
function is normally used so that a ringing phone can be picked up from another phone using the Pick Up
Group sequence , followed by the ring group number. It is also used to cause a group of phones to ring
at the same time, so that any one of the phones can be answered to accept the call.

* 0
11
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By factory default, ring group 0 is defined as all phones in the system except the PA speaker. This means that
you can usually pick up any ringing phone in the building by entering .

Also by factory default, ring group 1 is defined as containing the telephone line which rings through your
company’s overhead PA speaker. Unless your system administrator has changed the definition of ring group
1, you can pick up a call ringing over the overhead PA speaker by picking up any phone and pressing

.

Ring groups can also be assigned to extensions by the system administrator, so that when the extension num-
ber is dialed, several telephones ring at the same time. Any one of the telephones can be answered to receive
the call; the first telephone in the ringing group of extensions that goes off hook gets the call, the others get
dial tone.

Extensions numbers in the NexPath Telephony Server

There are eight different types of extensions in NexPath system:

1. Inside line extensions (default is 300-399)

2. Outside line extensions (default is 200-299)

3. Voice mailbox extensions (default is 500 -599 and 130-131)

4. Auto-attendant extensions (pre-configured as 120 (Day Program) and 121 (Night Program))

5. Park orbit extensions (default is 100 - 110)

6. Speed dial extensions (none predefined)

7. Public address extensions (special case of item 2 above, default is 111).

8. Extensions that ring several phones at once (special case of item 1 above, none predefined)

Any of these extensions types can be directly dialed from a telephone. The resulting function will be deter-
mined by the system programming for that extension type, i.e., you will ring a phone, seize an outside line,
enter voice mail, execute an auto-attendant program, etc.

The concept of extension numbers and their symmetric use throughout the system is a very powerful feature
of the NexPath Telephony Server.

* 0 0

* 0 1
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System speed dial numbers

Your system administrator can program the NexPath Telephony Server to recognized special three digit
numbers, called speed dial extensions, that translate to 7 or more digit off-site numbers. These can be used
for convenient direct dialing, or for convenience in transferring calls.

Contact your system administrator to determine if any speed dial extensions have been configured for your
system.
13
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Accept Calls/Do Not Disturb

Accept Calls

Do Not Disturb

When the NexPath Telephony Server is first started, your extension will automatically be placed in the
Accept Calls mode, which means that your phone will ring when someone calls you.

You can place your extension in the Do Not Disturb mode, though, during which calls made to your exten-
sion will go directly to your voice mail or directly to the number you specify as a forwarding number with-
out first ringing at your extension1. You may want to place your extension in the Do Not Disturb mode when
you are in a meeting and do not want your phone to ring or when you are out to lunch and do not want some-
one else to pick up your phone.

If your extension is part of a call distribution group and you place your phone in the Do Not Disturb mode,
then calls to the distribution group (Sales, for example) will not ring at your phone, but instead will go on to
the next extension in the group. Calls placed by dialing your extension number directly, however, will be
routed as described above.

To put your extension in the Do Not Disturb mode:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Do Not Disturb sequence .

3. Enter your extension number.

4. If prompted, enter your password2, or a password with administrator privileges.

5. If your password was accepted, you will be notified that your extension has been placed in the Do Not
Disturb mode.

6. Hang up.

1. If your extension has not been configured to support voice mail and you have not set up call-forwarding for your exten-
sion, your phone will ring even if you place it in the Do Not Disturb mode.

2. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.

* 8

* 9

* 9
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To return your extension to the Accept Calls mode:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Accept Calls sequence .

3. Enter the number of the extension you wish to change to Accepting Calls.

4. If prompted, enter your password1, or a password with administrator privileges.

5. If your password is accepted, you will be notified that your extension is now accepting calls.

6. Hang up.

Note There is no indication at your phone whether your extension is in the Accept Calls mode or the Do Not
Disturb mode. If you want to be sure to receive calls, you can enter the Accept Calls sequence at any
time, even if your extension is already in the Accept Calls mode.

1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.

* 8
15
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Barge In

Barge In

Barge-in is the process of breaking into a conversation. To barge into your own voice mail extension, for
example, while someone is leaving you voice mail:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Barge-in sequence .

3. Enter the number of your voice mail extension.

4. If prompted, enter your password1, or a password with administrator privileges.

5. If your password is accepted, you will be connected to the person currently leaving you a message.

Note If your phone is still ringing, you can usually pick up the call from any other telephone in the building
by picking up a phone and entering the Pick Up Ring Group 0 sequence .

If your system administrator has given your account Barge-in/Listen-in permissions, you can also use the
sequence described above to barge into other people’s conversations while they are on the phone. Check
with your system administrator to see if you have barge-in permission. You do not need Barge-in/Listen-in
permission to barge-in to voice mail in progress in your own voice mail boxes.

Barge-in and Listen-in can be blocked on a line by the system administrator, by setting the line as a Secure
Line.

Note When you barge into an existing conversation, the party at the extension number you barged into will
hear three short beeps, indicating that someone is barging into his or her call.

WARNING: Barge-in permissions also allow Listen-in. Listening-in to a conversation without the consent of one or
both parties may be a violation of local, state, and federal privacy laws. It is the responsibility of the user of the NexPath
Telephony Server, when using features of the system, to assure that they are in compliance with all applicable laws.

1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.

# 2
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Call Forwarding

Forward Calls

Cancel Forwarding

You can forward your calls to ring at any extension on the NexPath Telephony Server, or to an offsite num-
ber1. To set up call-forwarding:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Forward Calls sequence .

3. Enter your extension number.

4. Enter the number (either an extension or an off-site number) to which you want your calls forwarded, fol-
lowed by the key, or wait four seconds.

5. If prompted, enter your password2, or a password with administrator privileges.

6. If your password was accepted, you will be notified that call-forwarding has been enabled, followed by
the announcement of the forwarded number (i.e., you can verify that the number you entered is correct).

7. Hang up.

Note You do not have to enter a 9 to seize an outside line, if you are forwarding your calls offsite. The system
automatically seizes an outside line if the number is seven or more digits. However, you must enter a
one (if required) for a long distance number. Outside calls that are forwarded offsite may have reduced
quality and reduced audio levels. Consider using Centrex or CLASS type outside (CO) lines for best
forwarding quality. You can also use speed dial extensions for offsite forwarding, and get more control
over the call. See the Administrators Guide for details on speed dial extensions and CO line types.

When you enable call-forwarding for your extension, an incoming call will ring at your phone for 20 sec-
onds before being forwarded3. The call will then ring at the forwarding extension for 20 more seconds. If,
after this additional 20 seconds, no one has picked up the call and you have an exit extension (such as a

1. Your extension must have offsite forwarding enabled in the system configuration. Check with your system administrator.

2. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.

3. These are the factory-default forwarding and ringing delay times. Your system administrator can alter both of these times.

* 2
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* 2
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voice mailbox extension) associated with your extension, the call will go to the exit extension. That is, the
call will eventually go to the exit extension of the original extension the caller dialed.

If the extension is forwarded to a speed dial extension, and the speed dial number does not answer, the call
will go to the exit extension programmed in the speed dial extension configuration.

On the other hand, if you do not have an exit extension programmed, after the forwarding phone rings for its
additional 20 seconds, the caller will be notified that there is no one to take the call and will be disconnected.

Calls that are forwarded offsite (not using speed dial extensions) are monitored by the NexPath Telephony
Server, and the system will attempt to determine if a caller has answered. If not, the call will go to the exit
extension (such as voice mail), if the exit extension has been configured for the extension that was for-
warded. However, the monitoring of the progress of calls to outside lines depends on the ability to detect
call progress sounds on the telephone line. This is not a precise process and it may not be successful in all
cases. There can also be a delay before the call is connected.

Note Offsite forwarding is only permitted from extensions that have offsite forwarding enabled in the system
configuration. Check with your system administrator to see if offsite forwarding is enabled on your
extension.

Offsite forwarding will use Centrex or CLASS features (hook-flash transfers) if the CO line involved has
been designated as a Centrex or CLASS line.

Calls forwarded to a speed dial extension are handled differently. If an extension is forwarded to a speed
dial number, then the call progress monitoring is handled as specified in the speed dial extension configura-
tion. The system will not attempt to determine if the call connects unless so designated in the speed dial
setup. The exit extension as specified in the speed dial extension setup is used if the call fails to complete.

If callers are experiencing delays in calls that forward off-site, try using speed dial extensions where you
have more control of the call progress monitoring. You may also want your system administrator to create a
custom automated attendant, which is used as an exit extension in place of your voice mail box. This will
allow you to play customized messages to a caller before fowarding off-site, to prepare the caller for delays,
and to allow the caller the option of going directly to voice mail.

Speed dial extensions and exit extensions must be configured by your system administrator.
18
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Note An extension can only be forwarded once.

Call forwarding for your extension will remain in effect until you cancel call forwarding. To cancel call for-
warding:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Cancel Forwarding sequence

3. Enter your extension number.

4. If prompted, enter your password1, or a password with administrator privileges.

5. If your password was accepted, you will be notified that call-forwarding has been cancelled.

6. Hang up.

1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.

* 3
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Call Waiting

Enable Call Waiting

Pick up a Waiting Call

Swap Between a Current Call and a Call on Hold

Cancel Call Waiting

When call-waiting is enabled for your extension, you will hear two beeps in your conversation when you are
on the phone and a new call comes in1. When you hear these two beeps, you can decide whether to put your
current caller on hold and take the new call, or continue talking to your current caller and, depending on how
you extension is set up, let the new caller go to either your voice mail, get forwarded, or be disconnected.

You can eliminate call-waiting beeps from your conversations by disabling call-waiting for your extension.

To enable call waiting at your extension:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Enable Call Waiting sequence .

3. Enter your extension number.

4. If prompted, enter your password2 or a password with administrator privileges.

5. If your password was accepted, you will be notified that call-waiting has been enabled.

6. Hang up.

If you enable call waiting for your extension and you are on the phone when another call comes in, you will
hear two short beeps in the middle of your existing call. You can press to put the current call on
hold and answer the new call, or you can ignore the new call and let it go to your voice mail.

Note that if you pick up the incoming call, you can use the Swap Hold sequence to toggle
between the two calls.

1. Your caller will not hear these beeps, only you will.

2. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
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To disable call waiting at your extension:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Disable Call Waiting sequence .

3. Enter your extension number.

4. If prompted, enter your password1, or a password with administrator privileges.

5. If your password was accepted, you will be notified that call-waiting has been disabled.

6. Hang up.

The NexPath Telephony Server’s default configuration allows a phone to ring 20 seconds before being for-
warded, or 20 seconds before being sent to voice mail or getting disconnected, though your system adminis-
trator can alter these times. If you do not pick up a waiting call and you have set up call-forwarding for your
extension, a waiting call will forwarded after 20 seconds. If you do not have call-forwarding enabled but do
have a voice mailbox, then after 20 seconds the waiting call will go to your voice mailbox. If you have nei-
ther call-forwarding enabled nor voice mail, then after the 20-second delay time has expired, the caller will
be notified that there is no one to take the call and the call will be disconnected.

1. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.

* 5
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Clear

Clearing a Command Sequence

After getting an inside dial tone but before finishing a command sequence, you can get back to an inside dial
tone by pressing the Clear sequence .

# #

# #
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Conference Calls

Set Up Conference

Add To Conference

The NexPath Telephony Server can allow up to four parties to be conferenced on a single conference call,
with the four parties being any combination of inside or outside lines.

To initiate a conference call:

1. Call your first party. This could be either an inside or an outside number.

2. Enter the Set up Conference sequence . This will put your current call on hold and request a
conference circuit from the system. If a conference circuit is available, you will get an inside dial tone. If
no conference circuits are available, you will receive an error message and be re-connected to your first
call. Wait and try again later.

3. After getting a conference circuit and an inside dial tone, dial the number of the next party you wish to
conference in. This can include making calls to parties on either inside or outside lines. If you cannot get
your second party, retrieve your first call from hold using and try again later.

4. Upon reaching your second party, enter the Add To Conference sequence . You, your first
party, and your second party will all be talking to each other.

5. To add a fourth party to the conference, enter again. The first two callers will remain con-
nected to each other, and you will receive an inside dial tone.

6. Dial the number of the next party you wish to conference in.

7. Upon reaching your third party, enter the Add To Conference sequence . You will be con-
nected to all three callers.

8. You may hang up at any time and leave the conference active. The conference will end when no more
inside lines are involved in the call.

Note You can obtain a conference circuit before calling your first party by skipping step 1 above.
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Day Ringing/Night Ringing

Enable Day Ringing

Enable Night Ringing

The NexPath Telephony Server has two modes of operation that affect both the ringing of all extensions and
the auto-attendant: Day Mode (day ringing) and Night Mode (night ringing). Each extension can pro-
grammed to ring at different lines or groups of lines when the system is switched from Day Mode to Night
Mode. For example, an extension may be programmed so that calls placed to it ring one particular phone
when the system is in Day Mode, but ring all the phones in an entire ring group when the system is in Night
mode so that anyone left in the building can pick it up.

The auto-attendant may also have a Day Mode program and a Night Mode program. A different message
and set of choices may be presented to the caller depending on whether it is during regular business hours or
after hours. All of these features depend on the configuration and setup that is done by the system adminis-
trator when the system is installed or configured.

To enable day ringing (and disable night ringing):

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Enable Day Ringing sequence .

3. If prompted, enter your password1, or a password with administrator privileges.

4. If your password was accepted, you will be notified that day ringing has been enabled.

5. Hang up.

To enable night ringing (and disable day ringing):

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Disable Day Ringing sequence .

3. If prompted, enter your password1.

4. If your password was accepted, you will be notified that day ringing has been disabled.

1. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
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5. Hang up.

Note Your system can configured to switch automatically between Day mode and Night mode. See your
system administrator for details on whether or not your system is configured to do so.
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Disconnecting

Disconnect Call

You can disconnect from a call without hanging up. Once you have entered a password, you may want to do
this to avoid losing password protection or perhaps for other reasons. If your are using an inside extension
that automatically seizes an outside line (sometimes called assumed dial nine), this sequence will disconnect
from the outside line and return inside dial tone.

To disconnect from a call, or to disconnect from an outside line and obtain inside dial tone, without actually
hanging up the phone:

1. Enter the Disconnect sequence .

2. You will receive an inside dial tone.

3. Enter a new command or the next number you want to dial.
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Do Not Disturb

See Accept Calls/Do Not Disturb
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Help

Help

To get a summary of all commands listed here from your phone:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Dial the Help sequence .

* *

* *
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Hold

Put A Call On Hold

Retrieve A Call From Hold

Swap Between a Current Call and a Call on Hold

The NexPath Telephony Server can place up to three calls on hold at a time on any one extension. The calls
are place on a stack, much like a stack of boxes or books. The last call placed on the stack using
is the first one retrieved when is entered. Calls place on hold at an extension can only be retrieved
from that extension (private hold). If you want to place calls on hold to be retrieved from any extension, use
park orbits (public hold). See Park Orbits on page 40 for a detailed description.

Calls placed on hold using the above sequences, or placed into park orbits, receive hold music, if enabled for
the line and external hold music is supplied to the system.

To place a call on hold:

1. Enter the Put Call On Hold sequence . You will get an inside dial tone, and are free to call a
new number, enter a command, or hang up.

Note If you inadvertently leave a call on hold and forget about it, you will get a short reminder ring every 45
seconds1.

To retrieve the call most recently put on hold:

1. Pick up the phone or otherwise get an inside line dial tone at the phone where the call was put on hold.

2. Enter the Retrieve Call From Hold sequence . You will be connected to the call most recently put on
hold.

1. This is the factory default value for the reminder ring delay time. Your system administrator can alter this time if desired.
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To swap your current call with the call most recently put on hold:

1. Enter the Swap Hold sequence . Your current call will go to the top of the hold stack, and you
will be connected with the most recent caller put on hold.

To get at a call on the hold stack when more than one call is on the stack:

1. Get an inside line. If you are on a call, you can hang up on this call without putting down the handset by
entering . You can also transfer the current call using the Blind Transfer sequence
or the Set Up Transfer and Complete Transfer sequences and respectively.

2. Take the most recent call which was placed on hold off of hold by entering the Retrieve Call From Hold
sequence .

3. Hang up or transfer this call.

4. Take the next call off of hold by entering the Retrieve Call From Hold sequence .

5. If necessary, hang up or transfer this call, and take the first call which was placed on hold off of hold by
entering the Retrieve Call From Hold sequence .

6. When done, hang up.
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Hook Flash the Central Office Line (Centrex and CLASSSM features)

Hook Flash the Central Office Line

You can send a hook flash to the central office line, rather than have the hook flash interpreted by the Nex-
Path Telephony Server. This is only useful if you have Centrex lines or CLASSSM features, such as three
way calling, enabled on your outside lines.

Note The ability to hook flash a Central Office line can be enabled or disabled on a CO line by CO line basis
in the NexPath Telephony Server. This feature must be enabled with the administration software in
order for the sequence to work. Otherwise the sequence is ignored.

To send a hook flash to the central office line (see the note above):

1. While connected to an outside (central office) line, enter . You should receive the signal from
the central office that the sequence is recognized, usually three short beeps and then central office dial
tone.

For example, to setup a three way call using CLASSSM features:

1. While connected to an outside (central office) line and talking to the first party, enter . You
should receive the signal from the central office that the sequence is recognized: three short beeps and
then central office dial tone.

2. Dial the second party.

3. When you are connected, enter again. You should now have a three way call.

Note You must subscribe to CLASSSM features from your telephone company in order to use the three way
calling described above.
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Inside Lines

When you first pick up your phone, the dial tone you hear is an “inside line” dial tone. This is a dial tone
provided directly by the NexPath Telephony Server and not by the phone company. When you have an
inside line, the NexPath Telephony Server is ready to accept both phone numbers to be dialed and the key
presses of the command sequences for the advanced operations described in this chapter and in the chapter
Voice Mail starting on page 51.

Some notes: After getting an inside line dial tone, if you do not press any keys, you will get a dial tone time-
out message after 90 seconds. Similarly, once you start dialing a phone number or command sequence, if
you wait more than 15 seconds between digits, the system will give you a keypad dialing time-out message
and then return you to an inside line dial tone. Also, if you make a call to another inside line and get a busy
signal and then forget to either hang up or otherwise disconnect from the call, you will get a busy signal
time-out message after 60 seconds1.

Often, the first thing you do after picking up your phone is dial to get an outside line. Once you do this,
however, the NexPath Telephony Server stops trying to interpret all key presses except hook-flashes, as
described in the beginning of this chapter2. Not all commands start with hook-flashes, however, so it is
important to know how to get back to inside line dial tone. The easiest method is to hang up for a second or
two and then pick your handset again. Another way is to wait until the phone company decides that your
phone has been off-hook too long and disconnects you. This is similar to leaving a phone off-hook too long
at home, but instead of hearing silence and then the loud “beep-beep-beep” that the phone company usually
puts out, the NexPath Telephony Server detects this condition, hangs up the outside line, and returns you to
an inside line dial tone. Yet another method is to disconnect from your current call is to use the Disconnect
sequence .

Sometimes, it is desirable to get an inside dial tone from outside your facility, especially when you want to
check your voice mail from home or from another facility. To get an inside line dial tone from outside your
building:

1. Dial your company and wait for your system to pick up.

1. These are factory default times, and can all be altered by your system administrator.

2. If your system is configured to perform area code lockouts, the NexPath Telephony Server will also check that the inside
line being used has permission to obtain an outside line, and that the area code being dialed is allowed for that line.

9
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2. During your company’s auto-attendant greeting, dial the number specifically set up by your system
administrator to give you an inside dial tone.

If your system is not programmed for an inside dial tone selection during the auto-attendant answering
sequence (it is not in the factory default), you can still get an inside dial tone by doing the following:

1. Dial your company and wait for your system to pick up.

2. During your company’s auto-attendant greeting, dial your own voice mail extension number.

3. When you hear your pre-recorded greeting, hit the key, then enter your password. You will be in voice
mail at this point, and if your intention was to check your voice mail, then you are ready to press for
Play, for Pause, etc., as outlined in the chapter Voice Mail starting on page 51.

If, on the other hand, you really need an inside line dial tone to perform some other function such as enabling
call-forwarding for your extension or putting your system in Night Mode, then once you are in your voice

mail, press (at this point, is the Exit Voice Mail sequence), and you will get an inside dial tone.

Once you get an inside line dial tone from an outside line, you can perform all of the functions you would
from inside the building EXCEPT pressing to get an outside line dial tone. This is done to prevent users
from dialing in from outside and then placing long-distance calls which get charged to the company.

#
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Line and Extension Numbers

Announce Line Number and Extensions

The Announce Line and Extension Number sequence is primarily of value when performing system
administration of the NexPath Telephony Server. The system will announce the physical line number and all
extension numbers associated with any telephone from which the sequence is entered.

can also used for performing system administration from a telephone. If you use and enter a
password with system administrative permissions and then press after the password is accepted, you
will get a list of all user numbers and their passwords (see the NexPath Telephony Server System Administra-
tion Guide for details on user numbers).
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Listen In

Listen In

Listen-in is the process of monitoring a conversation without notifying the participants. You can also listen
in (screen) voice mail in progress.

To listen into your own voice mail extension, for example, while someone is leaving you voice mail:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Listen-in sequence .

3. Enter the number of your voice mail extension.

4. If prompted, enter your password1, or a password with barge-in privileges.

5. If your password is accepted, you will be listening to the person currently leaving you a message.

6. If you want to Barge-in (take the call), enter . The voice mail recorded up to that point will be
saved, the recording will terminate, and you will be connected to the caller.

If your system administrator has given your account Barge-in/Listen-in permissions, you can also use the
sequence described above to listen into other people’s conversations while they are on the phone, for quality
control and monitoring purposes. Check with your system administrator to see if you have Barge-in/Listen-
in permission.

Listen-in and Barge-in can be blocked on a line by the system administrator, by setting the line as a Secure
Line.

You do not need Barge-in/Listen-in privileges to listen in to voice mail in progress on your own voice mail
boxes.

WARNING: Listening-in to a conversation without the consent of one or both parties may
be a violation of local, state, and federal privacy laws. It is the responsibility of the user of
the NexPath Telephony Server, when using features of the system, to assure that they are in
compliance with all applicable laws.

1. You will not be asked for a password if you entered it to enable some other command and have not hung up since then.
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Night ringing

See Day Ringing/Night Ringing
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Operator

Dial the operator

To reach the operator from inside your company:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Dial .

3. The operator’s phone will ring.

Your system administrator will set up a normal extension number as the operator’s extension. Dialing
from an inside line is a shortcut for dialing this extension, though you can get the same result by dialing the
full extension number. Your system administrator can configure your system so that if the operator is busy or
does not answer, your call will go to the auto-attendant.

Note Both inside and outside callers will get an entry error message if they try to dial (or, for that matter,
any other number) while ringing an inside line. To get back to the operator, they will need to allow voice
mail to pick up, then press .
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Outside Lines

Obtain an Outside Line

You will get an inside dial tone when you lift your telephone handset unless your extension has been spe-
cially set up otherwise. Once you have an inside line dial tone, to get an outside line:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Dial .

Note You will get a busy signal if you dial and all of the outside lines connected to your system are busy.

Your NexPath Telephony Server can be programmed to block dialing specific area codes from specific
phones or groups of phones. If you try to dial an area code that has been blocked on the phone you are using,
you will be disconnected and hear an error message, then get an inside dial tone.

On the other hand, your system administrator can assign you your own set of area code lockouts and permis-
sions. To override the area code lockouts on a particular phone with the area code permissions you have been
assigned personally:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter . The system will ask you for your password.

3. Enter your password.

4. If your password was accepted, you will get a voice prompt and another inside dial tone.

5. Enter .

6. After receiving an outside dial tone, dial the long distance number desired.

Check with your system administrator to determine the area code lockouts and permissions in place in your
system.

Note Each inside line can be programmed by your system administrator to seize a different group of outside
lines when is dialed. You can seize a particular outside line by dialing the outside line extension
number.
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Paging (Public Address)

If your system is connected to a PA system, your system administrator can configure one extension per card
as the paging extension1. When you dial this extension, you will be connected to the PA system and can
make announcements (For example, “Jim Williams, please dial 455.”).

To make an announcement:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Dial the paging extension number.

3. Begin speaking.

4. Hang up when done.

1. The factory default number for the paging extension is 111. An external amplifier is required (not supplied).
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Park Orbits

Calls on the NexPath Telephony Server may be put on hold such that any caller can pick them up. This type
of public hold is called a park orbit. Park orbits are essentially a special type of extension, one which does
not ring anywhere, and anyone can pick up.

Park orbits are useful in a company where a call must be put on hold, and a PA (Public Address) system is
available to notify the called party to pick up the call. By putting the call in a park orbit, the called party can
answer the call anywhere in the building.

Calls in park orbits receive hold music, if enabled for the line and external hold music is supplied to the sys-
tem.

A call is placed in a parking orbit in the same way that it is transferred to a regular inside line extension. To
put a call in a parking orbit:

1. While connected to the party, enter the Blind Transfer sequence .

2. Enter the desired park orbit extension number.

3. If your transfer was successful, you will hear a prompt telling you that the call was transferred and the
caller will be put on hold. If the park orbit you dialed is busy, you will get a busy tone and be reconnected
to your caller.

To announce that the call is on hold over the PA system:

1. Get an inside dial tone.

2. Dial the paging extension configured for your system (the factory default is extension 111).

3. Make your announcement.

4. Hang up.

To retrieve a call from park orbit:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Dial the desired park orbit number.
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Note Calls left in a park orbit too long will cause a reminder ring (a single, short ring) to be sent to the
originating extension every 45 seconds1.

Your system administrator will reserve a specific set of consecutively-numbered extensions as park orbits2.

1. This is the factory default reminder ring delay time. Your system administrator can alter this time.

2. The factory default is to use extension numbers 100 to 110 as the system’s park orbits, though your system administrator
can alter this.
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Passwords

Enter Password

Change Password

Passwords are required for a number of the operations described in this chapter, as well as for accessing
voice mail. Each user is assigned a unique password. When you enter your password, you identify yourself
to the system. This allows the system to block unauthorized users from forwarding your calls, retrieving
your voice mail, for example.

Note The factory-default configuration is for all passwords to be four digits long.

Once you enter a password, the system will know who you are and you will remain “under password protec-
tion” until you hang up. This means that any further operations you may want to perform which require a
password can be done without re-entering a password.

If you attempt to perform an operation which requires a password and you have not already “gone under”
password protection, the system will prompt you for a password. If this happens, enter your password at the
prompt to complete the operation. You will then be “under password protection” from then until you hang up
the phone.

In addition, you can also “go under password protection” by doing the following:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter . The system will ask for a password.

3. Enter your password.

4. If your password was accepted, you will get a voice prompt and another inside dial tone.

5. Perform the operation desired. Note that, instead of hanging up, you can finish one operation and start
another by using the Disconnect sequence .

To change your password:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Change Password sequence . The system will ask for the old password.
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3. Enter your old password. The system will ask for the new password

4. If the old password was valid and the new password was accepted, you will get a voice prompt saying the
password has been changed.

Note Some passwords are reserved for system use only. You will get an error message if you attempt to use
the Change Password sequence to change your password to one of the reserved passwords.

Your system administrator is in charge of assigning all passwords and permissions. In addition to allowing
you to access your voice mail and perform basic telephone operations, your system administrator can assign
you permission to:

• Change the system mode from Day Mode to Night Mode and back again.

• Override the area code lockouts in place on a particular phone with your own set of area code permissions
and lockouts.

• Barge into or Listen into other people’s calls.

• Perform system administration functions.

Ask your system administrator about the password and permissions you have been assigned.
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Pick up

Pick Up Ring Group

Pick Up Any Ringing Phone

Pick Up Ringing Speaker

Your system administrator can group telephones together into ring groups (also called pickup groups). See
the section entitled Ring groups and Pickup groups on page 11 for details.

To pick up a ringing phone within a ring group from a phone that is not ringing:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter the Pick Up Ring Group sequence , followed by the single digit representing the ring group.
You will be connected to the caller ringing the phone.

By factory default, ring group 0 is defined as the group of all extensions except the PA speaker. This means
that to pick up any ringing phone in your building, you can:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter . You will be connected to the caller ringing the phone.

Note Check with your system administrator to see how this ring group is defined for your system.

Also by factory default, ring group 1 is defined as containing the extension which rings over to the PA sys-
tem. This means that, if you hear a ringing phone over your PA system (usually a system is configured so
that this happens for incoming calls when the system is in Night Mode), to answer it, you:

1. Pick up any phone or otherwise get an inside line dial tone.

2. Enter . You will be connected to the caller ringing the phone.

Note Check with your system administrator to see how this ring group is defined for your system.

* 0

* 0 0

* 0 1

* 0

* 0 0

* 0 1
44



Telephone Operations

user.bk Page 45 Tuesday, September 23, 2003 10:06 AM
Record a Call

Record a Call

You can record a call in progress from an extension that is part of the call, by pressing the Record a Call sequence. The
system will prompt for a voice mail box number, and then a password1 for recording access, and then return to the call
and begin recording. If recording fails due to access privileges, you will receive an error message. Otherwise, recording
begins without any further system messages. Recording stops when the call terminates by either party hanging up.
Recording can only be initiated after a call has been connected and is in progress.

The file containing the recording of the conversation is saved to the voice mail box number which was provided as
described above, prefixed with “Rcd_” followed by the time and date that the recording was initiated. Any mailbox can
be used; the password entered has no connection to the voice mailbox, and is only used to provide access controls for
recording. However, recording will automatically stop when the length of the recording exceeds the maximum message
length of the mailbox.

In order to record a call, three permissions must be enabled by your system administrator using AdminTool:

1. The user initiating the recording, as identified by the password, must have barge-in/listen-in/recording privileges (the
default is recording not allowed),

2. The line that the user is talking to must have recording permissions enabled (the default is recording not allowed),
and

3. The system wide recording permission must be enabled (the default is recording disabled).

Recording will be denied, and an error message played, if any of these permissions is not enabled. For further informa-
tion about enabling permission to record a call, contact your system administrator or see the System Administration
Guide.

Due to hardware limitations, the party on the other end of the call may be lower in volume than the extensions that initi-
ated the call.

Recording a call has more flexibility if initiated from NexDial™, the NexPath network client for Windows. See Record-
ing a Call on page 81 for details. With NexDial you can start and stop recording with the click of a mouse.

WARNING: Recording a conversation without the consent of one or both parties may be a violation of local, state, and
federal privacy laws. It is the responsibility of the user of the NexPath Telephony Server, when using features of the sys-
tem, to assure that they are in compliance with all applicable laws.

1. You will not be asked for a password if you have already entered it once to enable some other command and you have not
hung up since then.
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Transferring Calls

Direct (Blind) Transfer

Set Up Transfer

Complete Transfer

A direct (or blind) transfer is when you transfer a call to another extension without first checking at that
extension to see if the party is available. Calls may be blind transferred to any valid three digit extension,
including park orbits, voice mail extensions, speed dial extensions, or auto-attendant extensions.

To perform a direct (blind) transfer:

1. While connected to a caller, enter the Direct (Blind) Transfer sequence .

2. Enter the number of the extension to which the call is to be transferred.

3. If your transfer was successful, you will get a confirmation message, followed by an inside dial tone.

Note If you perform a blind transfer to an extension that has voice-mail but no one picks up, then after 20
seconds the call will go to that extension’s voice mail. However, if you perform a blind transfer to an
extension that does not have voice mail and no one picks up, then after 20 seconds the caller will be
notified that no one is there to take the call and the call will be disconnected1.

4. If your call was unsuccessful (the extension dialed was invalid, for example), you will receive an error
message and be reconnected to your call.

Another type of transfer is Transfer with Consultation. This type of transfer allows you to find the person
you want to transfer the call to and notify them that a call is coming.

To perform a Transfer with Consultation transfer:

1. While talking the caller, enter the Set Up Transfer sequence .

2. You will get an inside dial tone and the caller will be put on hold.

3. Dial an extension, or a succession of extensions, to locate the party you wish to contact.

1. These are the factory-default ring delay times; your system administrator can alter this time if desired.
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4. When you have the desired party on the line, enter the Complete Transfer sequence .

5. The two parties will be connected. You will be disconnected from the call and will hear an inside dial
tone.

Note If you cannot reach the second party or the other party does not want the call, you can retrieve the
original caller from hold using the Retrieve Call From Hold sequence .

If you set up a transfer but do not complete it, and then forget that the party is on hold, you will get a short
reminder ring every 45 seconds1. You can retrieve a call from hold using .

If, after setting up a transfer using , you decide to make the call a conference call instead of com-
pleting the transfer, you can use the Add to Conference sequence instead of the Complete Trans-
fer sequence and you, the party you put on hold, and the person to whom you were going to
transfer the call will be connected together.

1. This is the factory default reminder ring time, and can be altered by your system administrator.
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Summary of the keypad sequences

Accept Calls/Do Not Disturb

• Accept Calls

• Do Not Disturb

Barge-in (See also Listen-in)

Call Forwarding

• Forward Calls nnn..

• Cancel Call Forwarding

Call Waiting

• Enable Call Waiting

• Pick Up a Waiting Call

• Swap Between a Current Call and a Call on Hold

• Disable Call Waiting

Clearing a Command Sequence

Conference Calls

• Set Up Conference

• Add To Conference

Day Ringing/Night Ringing

• Enable Day Ringing

• Enable Night Ringing

Disconnect From a Call

Help
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Hold

• Put a Call On Hold

• Retrieve a Call From Hold

• Swap Between a Current Call and a Call on Hold

Hook Flash to Central Office Line (Centrex/CLASSSM)a

Inside Line (Disconnect from CO line)

Line and Extension Numbers

• Announce Line and Extension Numbers

Listen-in (Screen Voice Mail) See warning belowb

• Listen in to a call or voice mail in progress

• Barge-in after listening

Operator

• Dial the Operator

Outside Lines

• Obtain an Outside Line

Paging

• Default extension number for paging 111

Park Orbits

• Default park orbit extension numbers 100 - 110

• Transfer to a park orbit

Passwords

• Enter Password

• Change Password
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Pick Up

• Pick Up Ring Group

• Pick Up Any Ringing Phone

• Pick Up Ringing Speaker

Record a Call (See warning belowc)

Transferring Calls

• Direct (Blind) Transfer

• Set Up Transfer

• Complete Transfer

a. This feature must be enabled for the Central Office line you are using with Admin-
Tool. See The NexPath Telephony Server System Administration Guide.

b. WARNING: Listening-in to a conversation without the consent of one or both par-
ties may be a violation of local, state, and federal privacy laws. It is the responsibil-
ity of the user of the NexPath Telephony Server, when using features of the system,
to assure that they are in compliance with all applicable laws.

c. WARNING: Recording a conversation without the consent of one or both parties
may be a violation of local, state, and federal privacy laws. It is the responsibility of
the user of the NexPath Telephony Server, when using features of the system, to
assure that they are in compliance with all applicable laws.
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CHAPTER 3 Voice Mail
The NexPath Telephony Server incorporates a complete integrated voice mail system, essentially allowing
each user of the NexPath Telephony Server to have his or her own answering machine.

Each user can be assigned his or her own voice mailbox. Each voice mailbox can be associated with one (or
more) normal (voice) extensions and is assigned its own, unique extension number so that it can be dialed
directly. Voice mail boxes can also be created and utilized independently of any inside extensions.

Voice mail messages are stored in each mail box until they are specifically deleted by the user. Messages
continue to accumulate up to the maximum limits set for each mail box in the configuration set up by the
system administrator. See “Voice mail” on page 52 in the System Administration Guide for further details.

You can access your voice mail from any telephone either inside or outside your building by dialing your
voice mail extension number, or, if the system is connected to a network, by accessing your voice mailbox
from a computer. See Chapter 4: Windows Desktop Tools- NexDial™ starting on page 67 and Chapter 6:
TelOper™: the Web Browser Desktop Interface starting on page 113 for details on accessing your voice
mailbox from a LAN connected computer.

Determining if you have new messages in your voice mailbox

You have a new message or messages if you pick up your telephone and hear a “on-off-on” or “stutter” dial
tone, for a few seconds, instead of the normal, steady dial tone.
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If you have a telephone with a voice message light, one that is compatible with the VMWI or FSK signalling
technique, then the voice message light will also be illuminated, indicating new messages.

The LAN based programs NexDial, NexDirector, and TelOper, also provide computer screen indications of
unread voice mail.

Accessing voice mail from your telephone

To get into your voice mailbox:

1. Pick up any telephone in the system.

2. Enter your voice mailbox extension number (as assigned to you by your system administrator).

3. During the playing of your greeting, press the key on your telephone.

4. Enter your password when prompted. If you make a mistake, you can press and start re-entering your
password, or press and return to your greeting.

5. If your password is accepted, you will be placed “in voice mail”, and the system will announce the num-
ber of new and old messages in your mailbox, or tell you that there are no new messages. Note that, even
if the announcement says you have no new messages, you can still play any old messages in your mail-
box by following the instructions presented below for playing back messages.

When you are “in voice mail”, there are two menus that you can access, the Main Menu and the Message
Menu. If you have unread messages, then you directly enter the Message Menu, as show in Figure 3-1

#

#
*
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below. Or, if you press from the Main Menu, you will reach the Message Menu. When in the Message
Menu of voice mail, the buttons on your telephone will have the following meanings:

When you press from the Main Menu, and there are messages in your voice mail box, then the first mes-
sage will begin playing immediately.

FIGURE 3-1. Telephone keypad when in voice mail: Message Menu
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If you do not have any unread messages when you enter voice mail, or you press from the Message
Menu, you will be at the voice mail Main Menu. When in the Main Menu of voice mail, the buttons on
your telephone will have the following meanings:

Note While you are “in voice mail”, the buttons on your phone will only perform the functions described
above. The other telephone system control sequences described in Chapter 2: Telephone Operations
starting on page 7 are not functional while you are in this mode. You can exit voice mail at any time
either by hanging up or by pressing the Exit Voice Mail key , at which time you will hear an
announcement that you are exiting voice mail and then an inside line dial tone.

To play back the messages in your voice mailbox:

1. Get into voice mail for your extension, as described above.

FIGURE 3-2. Telephone keypad when in voice mail: Main Menu
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2. If there are new messages, the first message will begin playing immediately. Otherwise, press the Play
key to begin playback of the first message in your mailbox. Message are sorted into two groups,
unread messages, and messages that have been listened to. For each group, note that playback will start
with the oldest message in your mailbox for that group. The messages are played back oldest first fol-
lowed by the next, and finally the most recent message (in each group). Once a message has been lis-
tened to, it moves from the unread group to the listened-to group, and is placed in time order for that
group. The unread message group is played first, followed by the listened-to message group.

3. Use the keys on the telephone keypad as defined in the Message Menu diagram above (Figure 3-1) to
pause, resume, skip forward 5 seconds, jump back 5 seconds, delete, or proceed to the next or previous
message.

Note After playback of the first message completes, the second message will not start playing until you press
the Next key , or the delete key to delete the message. If you wait a few seconds after a message
has completed, you will get a voice prompt to help you with the key assignments.

Forwarding a message to a another mailbox or a group

While playing a message, or after a message has completed playing, you can forward the message to another
mailbox or a group by pressing . You can then press to send the message without an introduction, or

to record an introduction to the forwarded message. The message, plus introduction if recorded, will be
also be prefixed with your Short Name, or your extension number, as described below in “Recording a short
name” on page 60.

If you choose to record an introduction, you can say your introduction and then press to complete record-
ing. An options menu will then allow you to review your introduction and make changes, and then you can
press again to proceed to deliver the message.

The system will prompt with a choice of sending the message to a group or voice mail box. If you select a
mailbox, you will be prompted for the mailbox number. If instead of entering a voice mail box, you enter an
inside extension number, the system will forward the selected message to the voice mail box associated with
that inside extension.

If you select forward to a group, and if groups have been configured for your mailbox, then the system will
announce a list of groups to select from. Press the key as prompted to select a group to which to send the
message. After selecting a group from the list, you can press to proceed or to cancel delivery.
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In order to forward a message to a group, the group must first be added to this mail box. See “Adding a
voice mail distribution group” on page 61 for details.

Replying to a message

You can reply to a message sent from another mailbox. You can only reply to a message sent from another voice mail-
box on the system; you cannot reply to a call from an outside line.

While playing the message, or after a message has completed playing, press . Record your reply and then press
to complete recording, and then to send the message, or to cancel delivery.

Call the person who left a message

Callers can enter a call back number by pressing then after leaving a message. You can dial the call
back number of a person who left a message by pressing while the message is playing, or after the mes-
sage has completed playing. Dialing the call back number will dial the number left by the caller, or will dial
the caller ID of the caller, if available. If the caller ID is dialed, then 11 digit calling is used, starting with a
1 followed by the area code and number. Otherwise, the call back number is dialed exactly as entered by the
caller, with no other digits prepended.

You can return to voice mail after dialing the call back number by pressing the key.

Getting a help message during voice mail

Whenever you are in the voice mail Message Menu or the Main Menu and you pause for a short time, the
system will prompt you with a voice message explaining the meaning of the telephone keys with regards to
voice mail operations.

You can get help while your are in voice mail as follows:

• Enter the voice mail Main Menu and doing nothing for a few seconds.

• Touch the Pound key while in the Main Menu.

• Pause a message (in the Message Menu) with the pause key and then wait a few seconds.
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To record your standard or alternate greeting

1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hit-
ting .

2. Press the Record Greeting key .

3. Then press to record the standard greeting, or to record the alternate greeting.

4. Wait for the “record greeting” voice prompt.

5. Record your greeting.

6. After you have finished speaking, press or to end recording your greeting.

To listen to your standard or alternate greeting

1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hit-
ting .

2. Press (the Play Greeting key)

3. Then press to play your standard greeting, or to play your alternate greeting.

To set your Standard Greeting or Alternate Greeting

You can choose between two greetings for your voice mail box. This is useful if you have a regular daily
greeting and a different greeting when you are out of the office. The Set Normal/ Alternate greeting key
toggles between these modes. To set you standard or alternate greeting do the follow:

1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hit-
ting .

2. Press to toggle the greeting mode between standard and alternate. The system will announce the set-
ting: Standard or Alternate. It will stay in this mode until you hit again from the Main Menu.

Note If you have not recorded your own personal Standard or Alternate greeting, then the system standard
greeting will be used: “The person you dialed is not available...”.
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Accessing your voice mail from an outside line

To access your voice mailbox from outside your facility:

1. Dial your company and wait for your system to pick up.

2. During your company’s auto-attendant greeting, dial your voice mail extension number (as assigned by
your system administrator). Or, if your company phone is generally answered by a receptionist, have the
receptionist transfer you to your voice mail box extension.

3. During the playing of your greeting, press the key on your telephone.

4. Enter your password when prompted. If you make a mistake, you can press and start re-entering your
password, or press and return to your greeting.

5. If your password is accepted, you will be placed “in voice mail”, and the system will announce the num-
ber of new and old messages in your mailbox, or tell you that there are no new messages. Note that, even
if the announcement says you have no new messages, you can still play any old messages in your mail-
box by following the instructions presented above for playing back messages.

6. Use the telephone keypad as described in the diagrams on page 52 and page 54 to play back your mes-
sages. Note that if you do not remember the key sequences available, you can wait a short time and the
system will announce them to you.

Note If you do not remember your voice mail extension number, you can dial your normal extension number
and wait for it to roll over to voice mail.

Getting into your voice mail box if your mailbox is full

If your voice mailbox is full and you try to access your voice mailbox from a telephone, you will get a, “This
voice mailbox is full” message. You can still get into your mailbox from your telephone, however, by first
“going under password protection” as follows:

1. Pick up a phone, or otherwise get an inside line dial tone.

2. Enter . The system will ask you for your password.

3. Enter your password.

4. If your password is accepted, you will get a voice prompt and another inside line dial tone.
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At this point, you are “under password protection” and you can enter your voice mail extension to get into
your mailbox. Once in voice mail, all of your normal voice mail functions will be available, such as for
PLAY, for DELETE CURRENT MESSAGE, etc. Removing some of the messages in your mailbox at
this time will eliminate the “mailbox full” problem.

You can also enter the , and then your password, during the announcement that the mail box is full.

Alternately, if you are connected to the NexPath Telephony Server over a network, you can use the NexDial
or TelOper program to delete messages from your voice mailbox. You can also use NexDial or TelOper to
copy messages from your voice mailbox to a local computer for storage.

To enter a numeric pager number

You can program any voice mailbox to dial a numeric pager when a new voice mail message is received.
The pager will be sent the caller ID of the person that left the message if you have caller ID enabled from
your telco, and the caller ID is not blocked or unavailable from the call. In the event the caller ID is unavail-
able, the extension number of the central office line that the call came in on is sent to the pager. In addition,
the voice mail box number and the number of new messages is also sent to the pager.

To announce your numeric pager number do the following:

1. Get into voice mail for your extension, as described above, and assure you are in the main menu by hit-
ting .

2. Press (the Change Pager Number key) either during or after the announcement of the number of
messages in your mailbox, to announce your pager number.

3. Press any key but or to return to the Main Menu in voice mail.

To delete your current pager number, do the following:

1. Get into voice mail for your extension, as described above, and assure you are in the main menu by hit-
ting .

2. Press (the Change Pager Number key) either during or after the announcement of the number of
messages in your mailbox.

3. Then enter to delete the current pager number and disable paging.
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To enter a new pager number, do the following:

1. Get into voice mail for your extension, as described above, and assure you are in the main menu by hit-
ting .

2. Press (the Change Pager Number key) either during or after the announcement of the number of
messages in your mailbox.

3. Then press to enter a new pager number, and terminate the entry with a key.

If your pager number is a long distance (10 digit) number, then you must precede it with a “1”. The system
does not automatically add a “1” to 10 digit numbers.

After pressing (the Change Pager Number key), all digits except or function as shown in Figure 3-
2 on page 54, to return to the Main Menu in voice mail. After one of these digits is pressed, the digits
and resume their regular functions as show in the Figure.

The NexPath Telephony Server is compatible with numeric pagers that accept the entry immediately after
answering the call. Pagers that have an attendant menu, or require additional PIN numbers to be entered, are
not compatible with the current release of the software.

Note Additional pager characteristics may be set using TelOper or NexDial.

Recording a short name

You should record a short name for your voice mail box, since this is the announcement that is prepended to
any message that is copied (forwarded) to another voice mail box. Otherwise, the copied message will be
identified as “Extension 501” or the like.

When you record your short name, it is copied to the file dial_nnn.au (nnn is the extension number, such as
301) in the auto-attendant area, and is used by the Dial By Name auto-attendant to announce your extension
prior to transfer. All extensions that forward to this voice mail box will have the file dial_nnn.au updated by
the new short name recording.

To record a short name, do the following:

1. Get into voice mail for your extension, as described above, and assure you are in the Main Menu by hit-
ting .
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2. Press and begin speaking at the “recording” prompt. You have three seconds to say your name, and
then recording automatically stops.

3. You can play your short name by pressing (make sure you are in the Main Menu as described in #1).

Adding a voice mail distribution group

You can use the telephone keypad to add a voice mail distribution group, to which you can distribute (or for-
ward) messages. Only system groups, i.e., groups created by the system administrator, can be added using
the telephone keypad. See “Voice Mail Distribution Groups” on page 83 in the System Administration
Guide for details on adding system groups. User groups can be added using the Windows program NexDial.
See “Adding and Using Voice Mail Distribution Groups” on page 90 in this manual.

Voice mail distribution groups must first be added before they can be used to which to send messages.
Select which group you want to add as announced by the voice prompts.

The addition of a system voice mail distribution group makes it available for forwarding only in the current
voice mail box.

Note You cannot forward or send messages to groups unless the group has been added for use by this voice
mail box. You can only add system groups from the telephone keypad. System groups are created by
the system administrator. See “Voice Mail Distribution Groups” on page 83 of the System
Administration Guide. You can create your own private distribution groups (user groups) using
NexDial. See “Adding and Using Voice Mail Distribution Groups” on page 90 for details.

Removing a voice mail distribution group

Voice mail distribution groups can be removed from the list of groups for this mail box, by pressing from
the Main Menu. Follow the voice prompts and select which group you wish to remove. If you do not make
a choice, after a few seconds, the system will return to the Main Menu.

The removal of a system voice mail distribution group only affects the current voice mail box.
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Sending a message directly from voice mail

It is possible to record a new message while in voice mail, and send it to either a group or another voice mail
box. This feature is selected from the Main Menu, by pressing the key. You will be prompted to first
record your message, then, allowed to choose whether you want to send the message to a voice mail box or a
group. If you select a group, you will be prompted to select the group from the list of groups configured for
this mail box. See “Adding a voice mail distribution group” on page 61 above.

During recording of your message after pressing the key, you can press the key at any time and the
system will pause recording and announce a menu of options. These options are similar to the options avail-
able to a caller while leaving a voice mail message (see below), and allow you to use the NexPath Tele-
phony Server as a simple transcription device. You can replay the message, pause it, skip forward or back 5
seconds, and resume recording or record over portions of the message. If you resume recording, you must
press the key to pause recording and access this menu again.

During recording of a message after the Send Message command, you can press , and you will be
prompted with the following choices: .

The system announces the menu of choices to assist the caller, after a user presses while in the recording
mode of the Send Message command.

If you resume recording and want to pause again, you must press the key to access this menu again.

Rewind and Play: Rewind and play message from the beginning.

Pause/Resume: Toggle between playing and pausing.

Record: Begin (i.e., continue) recording at the current location in the message (if not at
the end of the message, over-writing the message at that point).

Rewind and Record: Start over and re-record the message from the beginning.

Back 5: Skip back 5 seconds and begin/continue playing this message.

Forward 5: Skip forward 5 seconds and begin/continue playing this message.

Call back number: Enter a call back number.

Send: Send the message.

Cancel and return: Cancel the message, and go to the Main Menu.
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The following pictorial diagram shows the options as listed in the table above, for the Send Message com-
mand, after pressing during recording:

FIGURE 3-3. Keypad options for Send Message after pressing during Record.
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Features Available When Leaving a Message

There are a number of features that are available when a caller is leaving voice mail. You may want to make
the caller aware of these capabilities in your greeting. The “Press 1” function operates differently depending
on whether the voice mail greeting is still in progress, or recording has begun. This is described below.

Keys that callers can use during the greeting when they are in voice mail

You may want to let callers know they can press the following buttons while listening to your greeting but
before recording begins:

Keys that callers can use during or after recording a message

After recording begins, callers can press , and they will be prompted with the following choices: .

Go to the extension defined as the operator’s extension by your system administrator

Exit voice mail and go to the extension defined as the voice mail exit extension by your
system administrator (usually the top of the day auto-attendant)

Skip the rest of the greeting and go directly to record

Operator: Send the message, and go to the extension defined as the operator’s exten-
sion by your system administrator

Rewind and Play: Rewind and play message from the beginning.

Pause/Resume: toggle between playing and pausing.

Record: Begin (i.e., continue) recording at the current location in the message (if not at
the end of the message, over-writing the message at that point).

Rewind and Record: Start over and re-record the message from the beginning.

Back 5: Skip back 5 seconds and begin/continue playing this message.

Forward 5: Skip forward 5 seconds and begin/continue playing this message.

Call back number: Enter a call back number.
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The system announces the menu of choices to assist the caller, after they press while in the recording
mode.

Send and exit: Send the message, and go to the extension defined as the voice mail
exit extension by your system administrator (usually the top of the day auto-attendant)

Cancel and exit: Cancel the message, and go the extension defined as the voice mail
exit extension by your system administrator (usually the top of the day auto-attendant)
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CHAPTER 4 Windows Desktop Tools-
NexDial™
NexPath provides a network-based dialer application called NexDial™ for use on Win95/98/ME/XP and
Win2000 systems with the Release 7 software. NexDial™ is similar to Microsoft's dialer, but includes the
many features of the NexPath system, such as hold, transfer, consultation transfer, conferencing, and addi-
tionally voice mail access. There is also a Voice Mail indicator and a Do Not Disturb indicator. You can
maintain your own phone book, and view and filter the call log.

The NexDial program interfaces to the NexPath system using the Nexpath API, a LAN-based Simple Com-
puter Telephony Protocol (SCTP) that is more powerful and far easier to use than Microsoft TAPI. NexDial
was the first commercial implementation of SCTP. SCTP is a NexPath standard for client-server computer
telephony.

The NexDial program will run on any Win95/98/ME/XP or WinNT 2000 system with TCP/IP installed.
You must have TCP/IP installed and configured, and an IP address and/or a system name assigned to the
NTS Server, in order for NexDial to be able to contact the NTS Server. See the chapter Network Installa-
tion starting on page 21 of the System Administration Guide for details on connecting the NexPath Tele-
phony Server to a network.
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Installing the NexDial dialer program

1. Insert the NexPath Telephony Server Release 7 CD-ROM in the Win95/98/ME/XP or Win2000 system
from which you want to run the dialer.

2. Click on Start, then Run, then Browse and select the file setup.exe in the Release6\NexPathDialer sub-
directory of the CD-ROM. Follow the prompts to install the program on your system.

Note If you are upgrading a previous version of NexDial, it is not necessary to uninstall the previous version
of NexDial. The Install program will copy your configuration data to the proper place in the Windows
Registry, and label your current configuration Default as described in the steps below. The old version
of the NexDial executable will be overwritten with the new version.

Configuring the dialer

1. Once installed, start the NexDial program by clicking on Start, then Programs, then NexPath Dialer,
then NexDial.

FIGURE 4-1. Configuration Management Screen
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The NexDial Configuration Management window shown above will only appear if you have more
than one configuration defined. In situations where this is the first installation, there will not be any
configurations defined. In this event, click on Add, and a window will pop up prompting you for a con-
figuration name. Enter a descriptive name, such as “Ext. 301” and click OK. The Configuration win-
dow will then appear as show in Figure 4-2. You can then enter the system parameters as described
below.

Otherwise, if you have previously installed a version of the Dialer that did not have configuration man-
agement, your previous entry will get converted to a configuration named “Default”.

The configuration management screen is used to manage multiple dialer windows on the same client
computer. This will allow you to have several dialer windows running, each logged into a different
extension, or, if necessary, different NexPath Servers.
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2. To login to the NexPath Server, select the configuration that you want, and then click on Login.

3. You can always return to the Configuration Management window as follows: At the top of the NexDial
window, click on Tools, then Configure. The NexDial Configuration window will appear.

FIGURE 4-2. Configuring setup parameters for NexDialTM
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4. If you are defining a new configuration, click inside the System Name box, then type in the system
name assigned to your NexPath Telephony Server. If your system name is not available from DNS
(Domain Name Service), or in the \Windows\Hosts file, then you must type in the IP address of the
NexPath Telephony Server instead.

5. Add your extension number and password to the boxes in this screen. The extension number is the
number of the extension that you are controlling next to your computer. The password is a valid pass-
word on the NTS Server. The password must be the password of a user that owns, or has permission to
control, the extension you have typed in the extension box. The owner of an extension has permission
to control it, and any user with administrative privileges has permission to control any extension. If you
enter the password of a user that does not have permission to control this extension, you will get a con-
nection error.

6. If desired, you can also specify the extension numbers of up to three voice mailboxes that will be moni-
tored. If there is any unread voice mail in any of these voice mail boxes, an indicator will flash indicat-
ing new messages. The first voice mailbox in the list is the one that a call is sent to if the button Send to
VM is clicked when a call is ringing in, and the voice mailbox where a recording of a call is saved. If
you do not wish to be notified of any voice mail, record calls, or send calls to voice mail, these entries
may be left empty.

7. The password you use must have access to voice mail boxes, in order for the voice mail window to
allow access.

8. Click OK when done.
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9. If you would like for the dialer to screen-pop upon an off-hook condition, or upon an incoming call, or
display the caller name instead of the caller number (Caller ID), these options can be selected under the
Tools->Options menu.

You can also select “Strip Service Codes” and “Strip Carrier Access Codes” to cause NexDial to pro-
cess the dialed number display (Current Call in the bottom status area). Selecting these options will
delete codes like *82 or *10222 from the number that is displayed, for visual clarity.

FIGURE 4-3. The Tools->Options menu in NexDial
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You are now ready to use NexDial! To login to the NexPath Server, select the configuration that you want,
and then click on Login.

Note When a new configuration is activated using AdminTool on the NexPath Telephony Server, the
network connection will be terminated and restarted to all clients. This will cause an error box to pop-
up on the clients running NexDial. Click Okay on this pop-up, and then restart NexDial to re-login to
the Server. Otherwise NexDial will not be operational.

Features available with NexDial Dialer Window

Screen pops

Whenever a call is ringing your extension, or you have a waiting call, you can configure NexDial to de-ico-
nify (i.e., screen-pop) and focus to the top of your screen. You can then view the caller ID of the incoming
call before you answer it, and you do not have to search for the application among the various windows you
are using. You can also configure NexDial to screen-pop when you take your telephone off hook as well.
This is set under the Tools->Options menu.

Note The buttons listed below will be grayed out unless they are appropriate for the current state of your line.
For example, Dial will be grayed out until you take your phone off-hook, and Hold will be grayed out
until you’ve established a call. NexDial is designed to make calls with the telephone in the off- hook
condition. In the current software release, NexDial does not place on-hook calls (the TAPI applications
do, however. See the chapter Installing the NexPath TAPI 2.1 Service Provider starting on page 135
for details on installing TAPI.). NexDial is not a TAPI application.

Also, buttons will change names as appropriate to a line’s state. For example, the Dial button will
change to Transfer if you are on a call, since dialing would make no sense while in the middle of a call.
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The numeric keypad and the Dial/Transfer button

The numeric keypad within NexDial can be used to enter a phone number, or you can type a number in from
the PC keyboard. If you have dial tone, then the button below the Number to Dial box will say Dial, and
can be clicked with the left mouse button to dial that number. You can enter extension numbers or 7 or more
digit offsite numbers in the Number to Dial box. It is not necessary to enter a 9, but you must enter a 1 if it
is required by your telco. You can seize a particular outside line by entering the extension number of the
outside line, followed by a comma for a short delay.

If you are on a call, the button below the Number to Dial box will say Transfer, and can be clicked to trans-
fer your call to the number entered. This is equivalent to the Direct (Blind) Transfer as described in the
chapter Telephone Operations starting on page 46. You can only transfer to three digit extension numbers,
such as inside extensions, park orbits, voice mail boxes, automated attendant extensions, and speed dial
extensions. To transfer to offsite numbers, you must use either a speed dial extension, or a Setup/Complete
transfer as described below.

You can retrieve a call from a Park Orbit by entering the park orbit extension number in the Number to Dial
box, and clicking Dial. You must be receiving inside dial tone to retrieve a call from a Park Orbit.
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The NexDial application should appear similar to the following:

User speed dial buttons

Up to seven user defined speed-dial numbers can be specified for use inside NexDial. Use Edit->Speed
Dial 1-7 at the top of the NexDial window to set up the names and numbers to be associated with each speed
dial button. Whenever you are off-hook and have dial tone, you can click on any speed dial button and that
number will be dialed for you. When you are on a call, clicking one of the speed dial buttons will transfer
your call to that number.

FIGURE 4-4. NexDialTM Network Dialer Application.
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Note User speed dial buttons created in NexDial are not the same thing as system speed dial extensions, setup
by the system administrator.

You can program a speed dial button to pickup a ring group, by entering the group number (a number
between 0 and 9) in the Speed Dial Number box, and clicking on the option box Group to pickup at the bot-
tom of the Edit Speed Dial dialog window.

The function buttons below the keypad

The six buttons below the numeric keypad and the speed dial buttons allow complete call control from the
desktop. These buttons have the following functionality:

Hold If you are in the middle of a call:

• Pressing this button will push the current call onto the top of the
hold stack. This means that, if no one is in Hold 1, then the current
call will go into Hold 1. If there is already a call in Hold 1, though,
and you press Hold, the call that was in Hold 1 will be pushed down
to Hold 2, and the current call will go in Hold 1.

If you have inside line dial tone:

• This button will retrieve whatever call is currently in Hold 1, pulling
any other calls in the hold stack up one level

Swap Hold Swaps your current call with any call in Hold 1.

Disconnect Disconnects your current call, giving you back an inside line dial tone.
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Set up/Complete Transfer Will set up a consultation transfer to the number listed in the Number
to Dial box. That is, it will put the current call in hold, and give you
back inside dial tone, allowing you to dial another number. When con-
nected to this new number, the button will change to Complete Trans-
fer. Click on Complete Transfer to transfer the call currently on hold
to the party you just dialed.

If the party you called doesn’t want the call, disconnect from the new
party using Disconnect, then try another number or use Hold to
retrieve the first caller.

Pick up If you are in the middle of a call and have call-waiting enabled, you
will hear two beeps if a new call is received while you are off-hook.

Pressing Pick up will place your existing call on hold and pick up the
waiting call. You can then use Swap Hold to toggle between the two
calls.

Note: information on the incoming call will be displayed on the Incom-
ing Call status line.

Set up/Add to Conference Pressing the Setup Conference button puts the current caller on hold
and reserves a conference circuit. After connecting to a second party,
pressing Add to Conference brings the first caller back from hold, and
puts all three of you together in a conference call.

You can press Setup Conference again to place both parties on hold,
then call another party and add them into the conference by pressing
Add to Conference again.

Listen/Barge VM Clicking the Listen VM button will allow you to screen your voice
mail while it is in progress. You can listen without the caller’s knowl-
edge, and determine if you want to take the call. After you press the
Listen VM button, the button legend will change to Barge VM. Click-
ing it when it is labelled Barge VM will barge into the voice mail in
progress, if a caller is currently leaving a voice mail message. The
voice mail box used is the first voice mail extension that was setup in
the Tools->Configure screen.
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Send to VM Pressing the Send to VM button will send a ringing call, or a waiting
call, to the first voice mail extension that was setup in the Tools->Con-
figure screen. Your telephone may be either on or off hook for this
operation.

Call Waiting You can enable call waiting on your extension by checking the check
box next to this legend. With call waiting enabled, while you are on a
call, if another call comes in it will generate a “beep-beep” sound in the
telephone. The caller ID of the incoming call (if you subscribe to caller
ID from the telephone company) will be displayed on the Incoming
Call status area at the bottom of the NexDial window. You can pickup
the waiting call by clicking the Pickup button, as described above
under Pickup. You can disable call waiting at your extension by click-
ing on the Call Waiting check box until there is no check mark.

Do Not Disturb Pressing the Do Not Disturb button will toggle the extension on and
off line, i.e., will toggle the extension from Accept Calls to the Do Not
Disturb mode. When in the Do Not Disturb mode, the red Do Not
Disturb legend will appear in the lower right hand region, and the but-
ton will be red. In this mode, all calls will either go directly to voice
mail, or will go to the forwarded extension, or will ring busy. The
extension will also be removed from any call distribution group for
which it has been configured. It will be returned to the call distribution
group, and begin accepting calls, when in the Accept Calls mode (grey
button).

Not Forwarded/ Forward To To forward the extension to another number, enter the number in the
edit box and click the adjacent button. It should turn red with Forward
To on the button. Click the button again to cancel forwarding. You can
enter seven or more digit offsite numbers, if your extension has Offsite
Forwarding permissions. A leading 9 is not required, but you must
enter a 1 if your telco requires it. See your system administrator for
details.
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See Chapter 2, Telephone Operations for further information on using various telephone system call control
features.

Status information

Status information for your extension is shown below the ten buttons, including:

Voice Mail The voice mail button, located at the lower left hand corner of the
screen, will turn red if there is unread voice mail in one of the voice
mail boxes setup in the Tools->Configure screen. When button is
clicked, a separate voice mail window will pop-up that allows you to
review and manage your voice mail. See the next section Voice Mail
Access from NexDial for details.

Phone Book This button allows you to maintain a personal phone book on the Nex-
Path Server.

Current call Shows who called whom in the current call. For incoming calls from
outside the building, Caller ID information is displayed if available.

Hold 1 Shows the same information as the Current Call line above, but shows
it for the call placed at the top of the hold stack. This call can be
retrieved by getting inside line dial tone and pressing the Hold button.

Hold 2 Shows the same information as the Current Call line above, but shows
it for the call placed in the middle of the hold stack. Retrieving the call
in Hold 1 will move a call from Hold 2 to Hold 1.

Hold 3 Shows the same information as the Current Call line above, but shows
it for the call placed in the bottom of the hold stack. Retrieving the call
in Hold 1 will move a call from Hold 3 to Hold 2.

Incoming call Shows either the extension number of an incoming call, or, if the call
originated outside the building, Caller ID information if available. You
can use this information to decide whether or not to take the call
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Setting Day/Night Mode

If you have Day/Night Mode permissions, you can set the NexPath Telephony Server Day or Night mode.
Select Tools->Day/Night from the NexDial menu bar. Click on the radio button for the mode you wish to
set, the click OK to change the Day/Night mode setting. Click Cancel to cancel any changes and keep the
Day/Night mode the same.

Changing your password

To change your NexPath Telephony Server password, select Tools->Chg Password from the NexDial menu
bar. Enter your old four digit password, and your new four digit password, then click OK. Note that this is
the user password on the NexPath system, the same that you used for logging into NexDial or for accessing
your voice mail, and must be four numeric digits. Take care to remember your new password. Your system
administrator can recover your user password if you forget it, but recovering the administrator password is
very difficult and requires factory assistance.

Selecting the audio player

You can select the audio player of your choice for playing voice mail messages. Select Tools->Audio
Player. The Windows program mplayer32.exe is used by default. You may find that the component
player mplay2.exe or wmplay.exe in the Windows Media Player directory is preferable.

Voice mail If you have new (unread) voice mail, the VOICE MAIL button will
turn red in the lower left-hand corner of the NexDial window while
there are unread voice mail messages. You can press this button to pop
up a separate window to review your voice mail messages.

Do Not Disturb The words Do Not Disturb will flash in red whenever your extension
is in the Do Not Disturb mode.
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Recording a Call

You can start and stop recording of a call using NexDial. While connected to the other party you want to
record, select Tools->Record or Tools-> Stop Record. These items will be grayed out if (a) you are not
connected to another party, or (b) you do not have permissions to record a call. Record permissions are
enabled and disabled for the entire NexPath Telephony Server, for specific users, and for specific lines. See
Allow Recording in the chapter Software Configuration starting on page 62 in the System Administration
Guide for further details.

The recording of a call is saved to the first voice mail box entered in the configuration screen. See the sec-
tion Configuring the Dialer on page 71. Note that recording will automatically stop when the length of the
recording exceeds the maximum message length of the mailbox. If you wish to record long duration phone
calls, you should increase the maximum message length of the mailbox, or use a special mailbox for this
purpose. See Voice mail on page 52 in the chapter Software Configuration in the System Administration
Guide for further details on setting the maximum message length.

FIGURE 4-5. Starting and Stopping Call Recording
81



User’s Guide

user.bk Page 82 Tuesday, September 23, 2003 10:06 AM
Voice Mail Access from NexDial

By clicking the Voice Mail button at the lower left hand corner of the NexDial window, you will get a pop-
up window that shows current voice mail and allows you to listen to messages (either on your computer
using multi-media or through the telephone), delete them, copy them to other mailboxes, etc.

The voice mail box that you are accessing is shown in the selector box at the top of the window. If your
password allows you access to other mailboxes, then they can also be viewed by changing the selector box
next to the label Voice Mail Box. Otherwise, you may have access to only one voice mailbox. The voice
mail access window appears as follows:

FIGURE 4-6. The Voice Mail Window in NexDial

Notes can be added
for each voice message
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Playing back a message

To play a voice mail message on your computer, select the Listen with computer radio button at the bottom
of the Voice Mail screen. Then select a message to play by clicking on it. Then click the Play button and the
audio player will pop-up and play the message on your computer’s multimedia system. You must have an
audio card and speakers installed for this function to work.

If you do not have multimedia, or do not wish to listen with your computer, you can click on the Listen with
phone radio button and select a file to play. Lift the telephone receiver of the extension NexDial is logged
into, and click the Play button, You will hear the message being played on the telephone. Note that the stan-
dard voice mail control buttons on the keypad do not work in this mode, and there is no method of start/stop/
skip-ahead when you are playing the message over the telephone using your computer.

You can also play a message by double clicking it, rather than clicking on it and then clicking the Play but-
ton.

Note The Play button will be grayed out if you have not selected a file to play, or you have selected Listen
with phone and your telephone is not off-hook.

Calling the call back number

You can dial the caller ID or callback number of the person that left the message, and select whether the call
back should be a 1+, 10 digit, or 7 digit number to dial. For each voice message that is highlighted, the call-
back number (if the caller left one), or the caller ID, is displayed near the center of the voice mail screen.
You can dial the displayed number by clicking the Dial button next to the number, with your extension off-
hook and receiving inside dial tone. You can edit the call back number, if necessary, before clicking on Dial.

Saving a copy of the voice mail file to the local computer

You can save a copy of any voice mail message to you local PC file system by doing the following:

1. Select the message you would like to save by clicking on it.

2. Select File -> Save on the voice mail dialog box menu bar.

3. Pick the name and location to save the file using the pop-up file browser.
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Forwarding a message to another voice mail box or a group

You can forward (copy) a message to another mail box by doing the following:

1. Select the message you would like to forward by clicking on it.

2. Select the voice mail box or group to which to copy the message, using the selector box by the Copy To
button at the lower portion of the Voice Mail dialog box.

3. Click on the Copy To button.

4. If you wish to copy (forward) the message without an introduction, click No.

5. If you wish to record an introduction to the message, lift your telephone off-hook and click OK on the
dialog box. Your telephone will announce “Recording...<beep>” and you can record an introduction up
to the maximum message length of your mailbox. When you have completed recording your introduc-
tion, either hang up or press the # key.

6. You can cancel copying the message at any step by clicking Cancel.

7. Confirm that you wish to forward the message by clicking OK on the pop-up confirmation box. You
can cancel the copying operation by clicking Cancel.

Note If the group to which you wish to copy (or forward) the voice mail message does not appear in the
selector box, then you need to add or create the group as described below in “Adding and Using Voice
Mail Distribution Groups” on page 90

Recording your Standard Greeting

The NexPath voice mail system allows two greetings, a standard greeting and an alternate greeting. You
can record your standard greeting from NexDial by doing the following:

1. Lift the telephone extension that NexDial is controlling

2. Click the Record Greeting button on the NexDial Voice Mail window

3. Record your standard greeting after the system announces “Recording...<beep>”

4. You can hang up or hit any telephone keypad key to stop recording.
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Recording your Alternate Greeting

To record your alternate greeting from NexDial, do the following:

1. Lift the telephone extension that NexDial is controlling

2. Click the Record Alt Greeting button on the NexDial Voice Mail window

3. Record your alternate greeting after the system announces “Recording...<beep>”

4. You can hang up or hit any telephone keypad key to stop recording.

Selecting the Standard or Alternate Greeting

If the check box next to the legend Use Alt Greeting is checked, then callers will be greeted with your alter-
nate greeting when they enter this voice mail box. If the Use Alt Greeting box is not checked, then they will
be greeted with your standard greeting. You can click on the check box to check and un-check it.

To play back your greetings

In addition to any messages left by callers, the Voice Mail file browser also displays the files Personal Greet-
ing (your standard greeting), Alternate Personal Greeting, and Short Name, if you have recorded any of
these. You can play the greetings back and listen to them in the same way you play any message. See “Play-
ing back a message” on page 83 above.

Deleting a message or messages

To delete a message, click on it, then click the Delete button, and answer OK to the confirmation box.

You can delete more than one message at a time by highlighting multiple messages in the file display, by
dragging the mouse and optionally using the Shift or Ctrl key in the standard manner of Windows.
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Announce Time and Date and/or Caller ID

You can have the NexPath Telephony Server insert an audio announcement of the time and date a message
was received (the default), or the Caller ID of the caller, or both at the beginning of a voice mail message.
This is done by clicking Configuration -> Voice Mail Headers from the Voice Mail window. The config-
uration options appear as follows:

FIGURE 4-7. Voice Mail Message Options
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Numeric Pager Notification

You can use NexDial to configure numeric pager notification of new voice mail. The numeric pager settings
setup screen is accessible from the voice mail window, under Configuration -> Paging Parameters, and
appears as follows:

FIGURE 4-8. Numeric Pager Notification for Voice Mail
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There is an edit box for entering your pager number. It is not necessary to enter a “9” to seize an outside line
(pagers are assumed to be outside numbers), but you must enter a “1” if is it required to dial the number. In
addition to the pager number, you can set the separator character and a pager delay for fine tuning the inter-
face to a paging service. The separator character is sent to visually separate the caller ID of the caller leav-
ing voice mail, from the voice mail box number, and the number of unread messages, to assist in readability.
It defaults to a ‘*’, and is displayed as a ‘-’ on many pocket pagers. You can change this to ‘none’, or ‘#’.

Note The Nexpath system in the current software release does not support pagers that have a voice menu and
require additional digits to be entered to select numeric paging, or require PIN numbers to be entered.

The pager delay is the number of seconds of delay before sending tone information after connecting to the
pager service. Some pager services are not prepared to accept the touch tones (DTMF tones) as soon as a
connection is made. It may be necessary to use this delay to make the paging work properly.

When you have entered your pager settings, click on Save to stored them on the NexPath Telephony Server.

Numeric paging is disabled when the pager number is saved as a blank entry, which will display as ‘none’.

Note Pager services are notoriously unreliable, due to both equipment variations on receiving paging
requests, and antenna coverage and blackouts when inside buildings, etc. You may find that
occasionally paging requests are sent by the NexPath Telephony Server, but not successfully delivered
to your pager. Some voice mail systems automatically send three requests, to be sure of delivery. The
NexPath system does not do this at present, but it is under consideration.
88



Windows Desktop Tools- NexDial™

user.bk Page 89 Tuesday, September 23, 2003 10:06 AM
Email Notification

You can use NexDial to configure notification by email when you have new voice mail. The configuration
screen is accessible from the Voice Mail window under the menu bar Configure -> Email Parameters, and
appears as follows:

Note The Configure -> Email Parameters selection will be grayed out and will not be accessible if email
notification has not been enabled for this voice mailbox. Contact your system administrator to enable

FIGURE 4-9. Email Notification for Voice Mail
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email notification for your voice mailbox if the setup screen is not accessible. Enabling email
notification must be done in AdminTool by an administrator.

Fill in your email address, and the IP address of your mail server. You can use the system name if DNS has
been enabled on the NexPath Telephony Server and you have DNS service. Unless you have the services of
a network expert, who is very familiar with DNS setup and mail hosts, you will have fewer configuration
problems if you use the IP address of your mail host.

Note It may be necessary to provide the NexPath Telephony Server with an acceptable Domain Name, in
order for email to work with certain mail hosts, such as with Linux RedHat 6.0 and later. The reason for
this is anti-spamming protections in mail host software (e.g., sendmail), that will not allow a
connection from a client unless it provides a fully qualified domain name in the protocol interchange.
The default used is nexpath.com, which may not be accepted by your mailhost. See the the chapter
Network Installation starting on page 21 in the System Administration Guide for details on setting the
network parameters such as domain name.

Some mail hosts require a login to send mail, referred to as an SMTP login and password. If your mailhost
requires this, put these values in the appropriate boxes. Note that the SMTP password is stored encrypted on
the NexPath Telephony Server, and is not echoed back in clear text to any network application. Four aster-
isks will always show in this box regardless of what is entered.

You can select either a brief or long format for the email, to attach the voice mail audio file, and the option
of deleting the voice mail file after the email is sent, using this dialog box.

Adding and Using Voice Mail Distribution Groups

Groups may be added to each voice mail box so that voice mail messages can be distributed (copied or for-
warded), in one operation, to multiple mail boxes. In the NexPath Telephony Server, both system groups
and user groups exist. System groups can be added from the Voice Mail window, by selecting Configure-
>Voice Mail Groups on the menu bar. User groups can be created and added using the same procedure.

System distribution groups must be first created by the administrator using AdminTool. Then the system
group can be added to the choice of possible groups, to each voice mail box. System groups may be added
to the group distribution choice from either the telephone keypad or using NexDial. System groups cannot
be changed or edited.
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User created groups can only be created and added to a given mail box using NexDial. The group creation
function is not available from the telephone keypad. However, once created and added, user groups can be
utilized for forwarding messages from the telephone keypad. Distribution groups created by a user are pri-
vate to that user, and are not available for other users.

All voice mail distribution groups, whether system or user, have associated with the group a short audio
announcement that enunciates a descriptive name of the group. This audio announcement is used only from
the telephone keypad, to identify each group so that the user can select one for forwarding messages. If the
user creates his or her own local group, then he or she must also record a brief audio announcement of the
group name. This recording, for user distribution groups, is created from the same dialog box where the
group is created. It is recorded using the logged in telephone extension, as is common on the NexPath sys-
tem. If this recording is not created, then the group will not be added. The user should be aware of all
groups that are added in his or her mailbox, and make sure that audio clips for his or her personal groups are
descriptive and distinguishable from other groups in the list.

Once groups have been added (or created), whether system groups or user defined groups, messages can be
forwarded to groups using NexDial, via the Copy To button on the Voice Mail page. Groups to forward
messages to are listed in the selector box, along with the other voice mail boxes on the system.

FIGURE 4-10. Voice Mail Distribution Groups
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Personal Phone Book

The NexDial program can be used to maintain a personal phone book. This phone book is stored on the
NexPath Telephony Server, and so is available at any client workstation. The phone book is unique to the
individual user, identified by the secret password that is used to log in.

The phone book is accessed from the main NexDial window by clicking the Phone Book button at the bot-
tom of a page.

Each phone book entry can be added, edited, or deleted by using the buttons at the bottom of the page.

The phone book can be sorted alphabetically, on a given column, by positioning the mouse cursor at the top
of the chosen column and clicking the left mouse button. Click again and the column is re-sorted in reverse
order.

The phone book can be down loaded to the local system, or uploaded from the local client system, by select-
ing the File button on the menu bar as shown in the figure below.

FIGURE 4-11. Editing a user voice mail distribution group
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By applying a normal text editor to the file you save locally, you can see that the personal phone book file is
a pipe-separated list, where “|” is the vertical bar or pipe character. You can edit or otherwise revise your per-
sonal phone book file (perhaps by dumping the contents of an existing contact manager program such as
Act! into the file), and using either Notepad or Excel to maintain the file. The file should be stored as a text
file and each field should be separated by the “|” character.

FIGURE 4-12. Personal Phone Book

Click on any column
to sort on that column
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Viewing the Call Log

The system call log may be viewed or saved locally using the NexDial application. The system call log is
accessible from the main window menu bar at View-> Call Log.

You can filter the log for certain times and dates, by setting the filter parameters and clicking Filter. If you
do not have Administrator privileges, you will only be able to view calls to and from your extension.

Calls are stored on the server in multiple log files, each limited in size to about one megabyte. The most
recent call log is the file CallLog, next most recent CallLog.0, etc., up to CallLog.9. The call log
history is not stored past CallLog.9, so you may want to save these logs locally if you have or nearly have
ten call log files.

FIGURE 4-13. Viewing the system call log using NexDial.

Click on the column bar
to sort on that column.
Click again to reverse
sort order.
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Integration with Goldmine 4.0 and ACT! 3 & ACT! 4:

The NexDial program, when running, will contact Goldmine and ACT!, if they are also running, and initiate
a database look-up based on the Caller ID. Goldmine will popup a dialog box informing the user that an
incoming call is available, and indicate if it is found in the database. It allows the user to decide if the con-
tact record should be accessed. ACT! does not pop-up a dialog box, but silently selects the contact record if
the caller ID is found in the database.

Note Caller ID (number and/or name) must be subscribed to from your telephone company in order for it to
be available to the NexPath system and NexPath software programs. In most locations in North
America, it is not a standard feature but a special service only available as an extra monthly charge.
Contact your local phone company for details.

NexDial must be running (it does not matter if it is iconified or not) for the caller ID look-up interface to
these versions of Goldmine or ACT! to be functional.

To dial a call from Goldmine, ACT!, or Outlook, you must install the NexPath TAPI service provider, as
described in the chapter Installing the NexPath TAPI 2.1 Service Provider starting on page 135. Note that
TAPI is not required to run just NexDial. It is only required to use Goldmine, ACT!, or Outlook.

The NexDial caller ID interface to Goldmine and ACT! is provided since the caller ID interface from TAPI
either is non-functional or is not implemented by these programs. The interface to Goldmine and ACT! has
only been tested and verified on the versions mentioned above.
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CHAPTER 5 Windows Desktop Tools-
NexPath Call Director
NexDirectorTM is the NexPath Call Director program that runs on any Windows PC desktop. Using the
TCP/IP network, NexDirector communicates with the NexPath Telephony Server for status and control
information. NexDirector allows a user to view the NexPath Telephone System activity for inside and out-
side lines (extensions), park orbits, and voice mail boxes. With NexDirector, you can also control and direct
calls.

With NexDirector you can:

• View extension status, and determine whether an extension is on-hook, busy, ringing, on-hold, or in
Do Not Disturb (DND) mode.

• View the number that an extension is connected to.

• View which park orbits are occupied and what number they are connected to.

• View voice mail boxes and which ones have unread messages

• Transfer a call to an extension, a voice mail box, or a park orbit with the click of the mouse

• Grab a ringing call and connect it to your extension.

• Place a call to an extension with the click of the mouse.

• Select a specific outside line with the click of the mouse.

• Put calls on hold or place your extension in the DND mode.

• Disconnect from a call on your extension.
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NexDirector is designed to provide the user with the capabilities of a traditional call director console on the
computer screen. Instead of expensive hardware, the user is provided with a computer console and the abil-
ity to control calls with the click of a mouse.

NexDirector can be installed and run on multiple computers on the network. It uses Internet based TCP/IP
protocols to communicate with the NexPath Server. Each desktop installation is associated with a nearby
telephone by a login page, which requires a valid system extension and a valid user password (same as the
voice mail password) in order to log in.

System Requirements for NexDirector

NexDirector can be used on any Win95/98/ME or WinNT/2000 system with a network card and TCP/IP
enabled. NexDirector uses 2-4M of memory, so it should run on most computers with fairly modest memory
capacity.

NexDirector communicates with the NexPath Telephony Server using the TCP/IP protocol and the local
area network. You must have TCP/IP installed and configured, with an IP address assigned to your Windows
PC, and an IP address assigned to the NexPath Telephony Server, in order for NexDirector to be able to
communicate with the NexPath Telephony Server. Other network parameters must be programmed properly
for the two systems to communicate. See the the chapter Network Installation starting on page 21 in the
System Administration Guide for details on network setup.

Installing the NexDirector program

Note If you are upgrading a previous version of NexDirector, it is not necessary to uninstall the previous
version before installing the new version. The old executable will be overwritten, and the registry
entries created or copied automatically by the InstallShield program.

1. Insert the NexPath Telephony Server Release 7 CD-ROM in the Win95/98/ME or WinNT/2000 system
from which you want to run NexDirector.

2. Click on Start, then Run, then Browse and select the file setup.exe in the Release6\NexPathCallDirec-
tor subdirectory of the CD-ROM. Follow the prompts to install the program on your system.
98



Windows Desktop Tools- NexPath Call Director

user.bk Page 99 Tuesday, September 23, 2003 10:06 AM
3. Once installed, start the NexDirector program by clicking on Start, then Programs, then NexPath
Call Director, then NexDirector.

4. When you first run NexDirector, an error box appears, indicating that there are no configurations set up
yet. Click OK on this dialog box, then go to the NexDirector file bar (NexDirector will be small and
located in the upper left hand portion of your desktop) and select Tools->Configure. A blank Configu-
ration Management dialog box appears. Click on Add, and you are prompted to add a new configura-
tion: You can choose any name you wish to identify this configuration (no embedded spaces), then
click on OK. At this point, a Call Director Configuration dialog appears, where you can enter the net-
work and login parameters. See the next section “Establishing a network connection to the NexPath
Telephone Server” on page 99 for details on entering these parameters.

5. After you enter the parameters and click okay, the Configuration Management screen re-appears as
shown in Figure 5-6 on page 106. It now has the configuration you just created. Click on this configu-
ration to highlight it, and then click on Logon. After a few seconds, you should be logged into the Nex-
Path Telephony Server, with a view of the inside line extensions and mailboxes. In the future when you
start the NexDirector program, these settings will be remembered, and the program will automatically
log you in, if you have only one configuration. If you have multiple configurations, you will need to
choose one and click the Logon button.

Establishing a network connection to the NexPath Telephone Server

NexDirector communicates with the NexPath Telephony Server using the local area network (LAN), or
Ethernet. You must have TCP/IP enabled on your Windows PC, an Ethernet card installed and connected
the LAN, and a compatible IP address assigned to your Windows PC, in order to communicate with the Nex-
Path Telephony Server. You must also have assigned a compatible IP address to the NexPath Telephony
Server as well. See the the chapter Network Installation starting on page 21 in the System Administration
Guide for details on setting the IP address on the NexPath Server.

Login to the NexPath Server by selecting Tools -> Configure on the menu bar, using the login Configura-
tion dialog box as shown in Figure 5-1 on page 100. Click inside the System Name entry box, and type in
the system name assigned to your NexPath Telephony Server. If your system name is not available from
DNS (Domain Name Service), or in the \Windows\Hosts file, then type in the IP address of the NexPath
Telephony Server instead.
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Add your phone extension number and password to the boxes in this screen as indicated. The extension
number is the number of the extension that you are controlling next to your computer (i.e., the extension
from which you will answer and transfer calls). The password is a valid four digit user (i.e., voice mail)
password on the NTS Server. The password must be the password of a user that owns, or has permission to
control, the extension you have typed in the extension box. The owner of an extension has permission to
control it, and any user with administrative privileges has permission to control any extension. If you enter
the password of a user that does not have permission to control this extension, you will get a connection
error.

Note When a new configuration is activated using AdminTool on the NexPath Telephony Server, the
network connection will be terminated and restarted to all clients. This will cause an error box to pop-
up on the clients running NexDirector. Click Okay on this pop-up, and then either exit and restart
NexDirector, or select Tools -> Configure->Okay to re-login to the Server. Otherwise NexDirector
will not be operational.

FIGURE 5-1. NexDirector login dialog box.

System Name or
IP address

Extension you are using

4 digit voice mail password
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NTS Server Configuration Issues Related to NexDirector

NexDirector will display only the outside extensions or inside extensions that are included in the system
phonebook. Extensions are included or excluded from the system phonebook via AdminTool, by the sys-
tem administrator. In AdminTool, (administrator only) go to Edit Configuration->Extensions->Edit, and
click on Include in Phonebook. See the Figure 5-2 on page 101 below. This is described in more detail in
Inside Line Extensions on page 45 in the chapter Software Configuration, and Outside Line Extensions
on page 49 in the chapter Software Configuration, in the System Administration Guide.

The NexPath Telephony Server configuration must be saved and activated before the extension will appear
in the NexDirector display, if it was not previously included in the system phonebook. It may also be nec-
essary to re-initialize the button settings by clicking on Tools -> Reset Button Assignment on the menu bar.

FIGURE 5-2. Including Extensions in the system phonebook using AdminTool.
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You are now ready to use NexDirector!

Note NexDirector is designed to control calls (i.e., transfer, disconnect, etc.) with the telephone off-hook.
Clicking on the buttons with the left mouse button with the telephone on-hook will have no effect.

FIGURE 5-3. NexDirector Screen (Inside lines tab)
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Configuration and Setup

After logging in as described in “Establishing a network connection to the NexPath Telephone Server” on
page 99, you can set other configuration parameters at Tools->Options on the menu bar. The following dia-
log box appears:.

By default, NexDirector will display the caller’s number for any call connection information. If you would
prefer the caller’s name, then check the check box at the top. Note: Caller number and caller name (Caller
ID) are services provided by your telephone company, and must be subscribed to in order for the functions to
operate on the NexPath software.

This dialog box allows you to set the NexDirector to focus, or pop-up, on an incoming call to your exten-
sion, or when the phone is taken off-hook. It also allows the choice of caller name (instead of caller num-
ber), for each connection that is displayed on each view. Note: This information is provided in the Caller
ID service, which must be subscribed for with your telephone company in order for the NexDirector to
receive the information. To select one of these options, click in the box next to the option.

FIGURE 5-4. Options Configuration
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You can control the display of the number that calls are connected to, and remove certain number sequences
that are not important. For example, if you click on Strip Service Code, then the displayed number will
have entries such as *67 or *82 (these block or unblock Caller ID, for example) removed from the dialed
number display.

If you check Strip Carrier Access Code, then long distance access codes are removed from the displayed
number. These are dialing patterns such as *1010288, to access a long distance carrier of your choice.

NexDirector can scan and display the status of up to 96 outside lines, and 160 inside lines. When you first
run NexDirector, the maximum numbers will be set automatically based on the current configuration. You
can adjust the numbers on this dialog box to monitor fewer lines. By reducing the maximum number of
lines that NexDirector scans, you can reduce the number of tab views, for convenience.

You can also enter the number of rows and columns you want for this view. This is changeable on an
instance (or view) by instance basis. Or, somewhat more easily, you can resize the window using the mouse
in the traditional Windows fashion. See “Resizing the Window” on page 108 for more details.

Although each view or instance of the program (see “Configuration Management- Multiple Views” on
page 105) has the setting for maximum number of lines, only the settings in the first view have effect.

Tabs and Views

At the top of the window, just below the file bar on NexDirector, there are several tabs that control the dis-
play you are viewing. See Figure 5-5 on page 105. These tabs are labeled Park Orbits 1, Outside Lines 1,
Outside Lines 2, Inside Lines 1, etc. If your window has been sized so that all tabs do not display, then a pair
of arrows appears to the upper right hand side, which you can click with the left mouse to cycle from tab to
tab.

After cycling the arrows to the tab you are interested in, you must then click with the mouse on the tab to
bring it into view.

The arrows will not appear if the window is sized large enough so that all of the tabs can be displayed.
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The tab that is displayed is remembered for each instance of the program (see “Configuration Management-
Multiple Views” on page 105 below) and stored in the Windows registry. When you run the program at
another time, the same tab settings are presented for each instance of the program.

By clicking on the tabs, you can select which type of lines, and which group of lines, you are viewing.

Configuration Management- Multiple Views

You can have multiple views of NexDirector by opening several NexDirector windows. Each window has
its own login parameters, to allow for different extensions or systems to be managed. Additional logins are
created using the Configuration Management dialog, which is accessed at Tools->Configure on the menu
bar. See Figure 5-6 on page 106 for an example of the Configuration Management dialog box.

FIGURE 5-5. Using Call Director

Click to cycle through tabs

Click each tab to see each view

(only present if not enough room for all tabs)
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For each Configuration, there is a separate system name, extension, and password. Settings for window
size, tab selected, button customization, etc., are all stored separately in the Windows registry for each run-
ning configuration of the program. You could, example, create two configurations, both with the same
login, with one having the outside lines presented, and the other the inside lines presented in a larger win-
dow. Start each one from the Configuration Management window, so that two windows are running. As
long as each one has its own unique configuration name, any window customization or settings will be
remembered the next time you run the program.

Remember that the login extension is the extension that is controlled by NexDirector. Each window has its
own separate login extension, when started from the Configuration Management dialog box. So you can
only click on a button to transfer a call or dial a number if the login extension of the window you are clicking
in, matches the extension that you currently have off-hook. All call control is done with the extension off-
hook.

Customizing Buttons and Views

When each instance of NexDirector is started, extensions are automatically assigned to the buttons in that
view, using the active configuration from the NexPath Server. You can modify the button assignments and
position, to customize the label, or to put the buttons in an order that is easier for you to use, using the right
mouse button.

FIGURE 5-6. NexDirector Configuration Management Dialog Box
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To change a button setting, position the mouse over the button you wish to change. Then, click the right
mouse button and a dialog box will appear. For example, if you are editing an inside line, then an “Edit
Extension Button” dialog box will appear. You can select a line to assign to the button by clicking on the
line list to the left. Edit the name displayed in the edit box to the upper right if you wish to customize the
label.

If you wish to disable a button, select UNUSED BUTTON in the line list.

See Figure 5-7 on page 107.

FIGURE 5-7. Customizing buttons on NexDirector

Select which line you want
the button associated with here

Enter a custom button name
here

Right click mouse to bring
up this window
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Resetting Button Assignments

Occasionally you may find that you want to start over on the button assignments, because the telephone sys-
tem configuration has changed significantly. This can be done by resetting the button assignments.

To reset the button assignments to the defaults in the current Telephone System configuration, select Tools-
>Reset Button Assignment on the menu bar and confirm by clicking Okay in the confirmation dialog box.

Resizing the Window

You can resize the window of each instance of NexDirector as follows:

• Position the mouse at the edge of the display window until the cursor changes to a double arrow;

• Depress the left mouse button, and, while holding the button down, drag the window to the size you
want.

• NexDirector will force the window size to be the next smallest size that contains an even multiple
of buttons, so that no buttons are cut off.

You can also set the window size indirectly by specifying the number of rows and columns of buttons, using
the dialog box at Tools->Options on the menu bar. See “Configuration and Setup” on page 103.

Activity and Status

The extension assigned to each button is located immediately below the button. The following colors are
used to indicate status:

• Green: Inactive

• Red: Busy or occupied (i.e., in use)

• Red and Blinking: On Hold

• Yellow: Do Not Disturb mode

• Black: Dead Line

• White and blinking: Ringing
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• Blue: voice mail, no unread messages

• Light Red: voice mail box, with unread messages.

When an extension is connected to a call, the originating extension (or phone number) is shown, followed by
a “<->” which indicates a connection, followed by the destination extension (or phone number).

A Dead Line indicates a non-connected (or possibly non-functional) outside line, or an inside extension that
has been off hook for a long time, until the dial tone time-out state has been reached.

The voice mailbox buttons will be blue if there are no unread messages, and a light red color if the mailbox
contains unread messages.

Controlling Calls

NexDirector can be used to originate an inside call, transfer a call to an extension, park a call, transfer a call
to voice mail, or capture a ringing extension. All call control is accomplished with the left mouse button,
and your extension must be off-hook.

NexDirector controls and transfers calls associated with the controlling extension. The controlling exten-
sion is the login extension, as described in “Establishing a network connection to the NexPath Telephone
Server” on page 99. All call control must be done with the controlling extension off-hook.

Call An Extension

To call an extension, with your extension off-hook and receiving dial tone, simply click (using the left
mouse button) on the extension button of the extension you wish to call.

Transfer A Call

If you are connected to a call, you can transfer the call to another extension, park orbit, or voice mail box by
clicking on the extension, park orbit, or voice mailbox button to which you wish to transfer the call. Your
extension will go to inside dial tone when the call is transferred.
109



User’s Guide

user.bk Page 110 Tuesday, September 23, 2003 10:06 AM
To transfer the call you are connected to into a park orbit, click the park orbit button (your extension must be
off-hook and connected to a call). To retrieve a call that is in a park orbit, click the park orbit button (your
extension must be off-hook and receiving dial tone).

To transfer a call to voice mail, you must first answer the call. While connected to the call, click on the
voice mail box button to which you wish to transfer the call (your extension must be off-hook and connected
to the call). Your extension will go to inside dial tone when the call is transferred.

Retrieve a call from a Park Orbit

To retrieve a call that is in a park orbit, click the park orbit button (your extension must be off-hook and
receiving dial tone), and the park orbit button must have a call parked there, as indicated by a red park orbit
button. A green park orbit button is empty.

Put a call on Hold

To put the current call on hold, click the Hold button at the bottom of the screen (your extension must be off-
hook and connected to a call). To retrieve the call, click the Hold button again (your extension must be off-
hook and receiving dial tone).

Seizing a particular outside line

To seize a particular outside line, click on the outside line extension button (must be green or unused). Your
extension must be off-hook and receiving inside dial tone.

Picking up a ringing call

When a call is ringing, the extension that is ringing turns white and blinks. To capture the call to your exten-
sion, click on the blinking white button. You must be off hook and receiving dial tone at your extension to
grab a call.
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Do Not Disturb

To set the logged in extension as Do Not Disturb, click the Do Not Disturb button at the bottom of the
screen. This button will turn red when in the Do Not Disturb mode. To put the extension in the Accept
Calls mode, click the button again.

Disconnect a call

To disconnect from the call you are on, click the Disconnect button (your extension must be off-hook and
connected to a call).
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CHAPTER 6 TelOper™: the Web Browser
Desktop Interface
In addition to the command sequences outlined in previous sections of this manual, and the NexDial™ and
NexDirector™ Windows programs, you can control many of the functions of the NexPath Telephony
Server from your desktop computer using your web browser, if your computer meets the following criteria:

• Your computer is connected to the NexPath Telephony Server over a network which supports the TCP/IP
protocol.

• Your computer has Netscape 4 or Mozilla 5 (or later version) Web Browser installed.

The desktop web interface program is called TelOper.

Note TelOper is not compatible with Microsoft Internet Explorer (any version) as of Release 7 of the
NexPath Telephony Server software.

Talk to your system administrator about getting your computer to meet these criteria.

To Control your Phone from your Web Browser

1. Start your Netscape Web Browser program.

2. Select “Open URL” in your Web Browser.
113



User’s Guide

user.bk Page 114 Tuesday, September 23, 2003 10:06 AM
3. Specify the location to open as http://<system name>/teloper/1. A Web page similar that below should
appear2

1. Replace <system name> with the name assigned your specific NexPath Telephony Server by your system administrator, or
the IP address of the NexPath Telephony Server.

FIGURE 6-1. Log-in page for controlling your phone from your computer
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As described in the log-in page, enter your extension number and password, then click the OK button.

Note Because of security concerns, if you are running a Web browser at someone else’s computer, you can
still log in to the NexPath Telephony Server using your extension number and password, but you will
not be able to perform any of the telephone-centric functions like dialing a number from the Web
browser since your telephone is physically located elsewhere. You will, however, be able listen to your
voice mail using the computer and copy messages to other users.

Note There are other URLs that can be used in the system, other than the call control page, some of which are
only available to system administrators. To get a list of these, go to the page at http://<system name>/.
(The trailing “/” may be required if you are using an IP address). This will list several links that you can
click on to navigate to other web pages in the NexPath Telephony Server. Administration passwords
are required to view some of these links.

2. If this page does not appear, check that you have entered the proper URL and try again. If it still does not appear, consult
your system administrator.
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The Control page

If both the extension number and password you entered are correct, a new window will appear containing a
page similar to that shown below:

The buttons displayed the Control page can be used in place of or in addition to the command sequences
described previously in this manual. In other words, instead of having to place a call on hold by pressing

on your telephone keypad, you can simply press the Hold button in this page while you are con-
nected to a caller and the call will be put on hold. These functions will only apply, though, to the telephone
associated with your extension number, so your phone will have to be off-hook and connected to a call
before the Hold button will do anything.

FIGURE 6-2. The Control Page

Flash *
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Selecting a voice mail box to monitor

Your user name will be shown in the upper left corner of this page, along with your extension number.
Below them is a pull-down list labelled Monitor VMB containing all voice mail mailboxes to which you
have access. There is an additional entry at the bottom labelled USER. The USER selection represents all
voice mail boxes that you own, and will activate monitoring of all of those mail boxes. For most people, this
will be a list with only two entries, the user’s voice mail box and the USER entry, and both represent the
same thing. The voice mail mailbox selected from this pull-down list will be the one used by the voice mail,
VM Barge-in, Send to VM, and Password buttons on this page. If you own more than one voice mail box,
and you select USER, then the mail box selected by these functions will be the first one that you own in the
list. You can tell which voice mail boxes are being monitored by looking at the information in the status
frame in the lower left hand corner of the main screen.

VM Barge-in

If you miss picking up your phone before a call rolls over to voice mail, you can still connect to the caller
while he or she is leaving you a message by clicking this button. Your phone must be off-hook for this button
to have any effect, though.

The Listen feature is not implemented at this time in TelOper.

Send to VM

If your telephone is ringing, and you do not wish to take the call right now, you can send it directly to voice
mail by clicking on Send to VM (Send to Voice Mail) while it is ringing. It will immediately be transferred
to your voice mail box instead of ringing until it rolls over to voice mail.

Hold

While you are on a call, you can click on the Hold button to put the caller on hold. Click again on the Hold
button to bring the call back, or Swap Hold to simultaneously put a current conversation on hold and
retrieve the call on hold.
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Note You can put up to three calls on hold simultaneously, but to retrieve them, you will have to take them off
hold in the last-in/first-out order. The hold system works like a stack of boxes, and so is called a hold
stack. The last call put on the top of the hold stack is the first one that you get when you take a call off
of hold.

Call Control

In the upper right of the Control page is a pull-down list labelled Name which contains a list of all exten-
sions available in your system. Below it is a fill-in box labelled Number. The buttons in the Call Control
area (Dial Number, Blind Transfer, etc.) will use the number in the Number box as the phone number to
dial, transfer to, etc. The pull-down Name list, in turn, can be used as a convenient way of filling the Num-
ber box.

Once you have filled in Number, you can click on the Dial button to dial it (or click Enter on your key-
board). When your party picks up, Dial will turn to Disconnect, allowing you to hang up without releasing
the line, the same as if you used the Disconnect sequence (see Disconnecting on page 26 in the
chapter Telephone Operations for details).

Note You can use the PhoneBook button in the Call Control area to both add numbers to the pull-down
Name list and to add speed-dial buttons to the browser frame area to the right of the Call Control area.

Other buttons on this page include:

• Blind Transfer. Select the extension from the Name list, then click this button to transfer a call to that
extension.

• Set up Consul. Transfer. To set up a transfer with consultation, click Set up Consul. Transfer. This will
put your current call on hold and give you inside dial tone. Dial the party to whom the call is to be trans-
ferred using either your telephone keypad or the Name list, Number box, and Dial button in this page.
Once connected, the Set up Consul. Transfer button will change to Complete Transfer. You can click
on Complete Transfer to complete the transfer, or From Hold to get the caller back if the party did not
answer or does not want the call.

• Set up Conference. To set up a conference, call your first party and tell them you are going to put them
on hold while contacting the next party, then click on Set up Conference. Your party will be put on hold,
and you will get an inside dial tone.

Flash #
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Dial the next party to be added to the call, using either your telephone keypad or the Name list, Number
box, and Dial button in this page. Once connected, this button will change to Add to Conference. Click
on Add to Conference to bring your original caller into this new call. The button on this page will
change back to Set up Conference.

To add a fourth party to the call, click on Set up Conference again, then dial the fourth party and click
on Add to Conference after the call is established.

• Call Waiting. If you have call waiting enabled for your extension and you hear a “beep-beep” tone while
in the middle of a conversation, you can use this button to pick up the incoming call and place your cur-
rent caller on hold. You can then use the Swap Hold button to transfer between the two.

• Call Barge-in. If you have barge-in privileges, you can select an extension from the Name list, then click
on this button to barge into an existing call on that extension.

Using the Ring Group button

This button can be used as an alternative to entering the Pick Up Ring Group command sequence from
your telephone. See Pick up on page 44 in the chapter Telephone Operations for details on ring groups.
Clicking on the Ring Group button brings up a page similar to the following:

To use this page, pick up your phone, select the pickup group you want to pick up from the pull-down list,
then click on the Pick Up Group button.

FIGURE 6-3. A Ring Group page

* 0
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The Voice Mail page

When you receive new voice mail, a Voice Mail Alert box similar to that below will appear on your screen,
and the word “VoiceMail” in the voice mail button in the Control page will also turn red. The alert will indi-

cate the number of new and old messages, and the voice mail box to which the new message arrived.

FIGURE 6-4. A voice mail alert box
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Clicking on the voice mail button in the Control page brings up a window similar to the following:

FIGURE 6-5. A sample voice mail page
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Your user name is listed at the top of this window. Below it is a pull-down list of all voice mailboxes to
which you have access. For most people, this will be a list with only one entry, so clicking on it will not actu-
ally bring up any more entries.

Setting message, pager, and email parameters

At the bottom of the Voice Mail page, you can set whether you want a voice announced time and date at the
beginning of each voice mail message, or if you want the caller ID announced at the beginning of each mes-
sage, or both. See Figure 6-5 above. Select Announce Time of Day (on or off) and Announce Caller ID (on
or off). Then click on Change Voice Mail Settings to submit it to the NexPath Telephony Server. A confir-
mation box will appear to ask if you are sure, and the voice mail window will refresh if the submit was suc-
cessful. Note that the voice announcements are recorded as part of the message, so the settings only take
affect on future voice mail messages.

Similarly, your numeric pager settings can be changed. In addition to the pager number, you can set the sep-
arator character and a pager delay for fine tuning the interface to a paging service. The separator character
defaults to a ‘*’, and is displayed as a ‘-’ on most pocket pagers. This assists in readability, to separate the
caller ID from the voice mail box number, and the number of unread messages currently in the mail box.
You can change this to ‘none’, or ‘#’.

Note The Nexpath system in the current software release does not support pagers that have a voice menu and
require additional digits to be entered to select numeric paging, or require PIN numbers to be entered.

The pager delay is the number of seconds of delay before sending tone information after connecting to the
pager service. Some pager services are not prepared to accept the touch tones (DTMF tones) as soon as a
connection is made. It may be necessary to use this delay to make the paging work properly.

When the pager entry is blank or ‘none’, numeric paging is disabled.

Note Pager services are notoriously unreliable, due to both equipment variations on receiving paging
requests, and antenna coverage and blackouts when inside buildings, etc. You may find that
occasionally paging requests are sent by the NexPath Telephony Server, but not successfully delivered
to your pager. Some voice mail systems automatically send three requests, to be sure of delivery. The
NexPath system does not do this at present, but it is under consideration.
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You can use TelOper to configure notification by email when you have new voice mail. The parameters are
entered at the bottom of the Voice Mail window.

Note The Email settings will not be accessible if email notification has not been enabled for this mail box.
Contact your system administrator to enable email notification for your voice mail box if the setup
parameters are not accessible. Enabling email notification must be done in AdminTool by an
administrator.

Fill in your email address, and the IP address of your mail server. You can use the system name if DNS has
been enabled on the NexPath Telephony Server and you have DNS service. Unless you have the services of
a network expert, who is very familiar with DNS setup and mail hosts, you will have fewer configuration
problems if you use the IP address.

You can also enable the following email options:

• Attach the voice mail file to the email message;

• Delete the voice mail file from the NexPath Telephony Server after the email is sent;

• Use the brief form of the email, which is useful if sending email to cell phones.

In addition, some email servers require a login and password to send email. This is known as SMTP login,
and a space is provided for the username and password for SMTP login. For most situations, this is left
blank. Note that the SMTP password is not sent back to the browser over the network, for security reasons,
so the password field will always show four asterisks after an update, regardless of what is entered into the
password field.

Dialing Method for Call Back

You can select the method for dialing the person that left you a voice mail message. First, click on the mes-
sage that has the caller ID you wish to re-dial, then click on the radio button for the method of dialing you
wish to use. This may be 1+ dialing, where a ‘1’ will be prefixed to the 10 digit number, or 10-digit dialing,
where the 10 digits will be dialed without a ‘1’, or 7 digit dialing, where the area code will be removed and
just the last seven digits dialed. Then lift your telephone from the receiver and click on Dial. See Figure 6-
5 above. This setting has no effect when dialing inside extensions.
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Other Voice Mail Features

Below the voice mailbox list is a window which lists your voice mail greeting (if you’ve recorded one), the
introductory message to be used with the “Copy Message to” command (explained in more detail below) if
you’ve recorded one, and all voice mail messages currently in the selected mailbox. Each message in the
mailbox is identified by the time and date it was recorded, along with its length, and the telephone number of
the caller (Caller ID) if available. New messages are identified with a § prefix. Message are listed in reverse
chronological order (i.e., newest messages are listed first).

To play back either a message, your greeting, or the “copy to” introductory message, use your mouse to
highlight an item in the listing window, then click the Play button. See below for details on selecting
whether the message will be played over your computer’s speakers or through a telephone.

You can delete an item from this window by selecting it and then clicking on Delete. Only one message can
be deleted at a time.

To copy the audio file associated with an item in this window to a local drive, press Save Local. You may
want to save important voice mail messages on your local computer because you will eventually run out of
room in your voice mailbox on the system1.

To review your voice mail greeting, click on the message entitled “Personal greeting” in the message win-
dow and then click the Play button. You can re-record your greeting by clicking on the Record Greeting
button and following the prompts.

You can copy a voice mail message from your mailbox to someone else’s. To copy a message, record an
introductory message using the Record Copy to: Intro button (if you have not already done so), then select
the message you want to copy, use the pull-down list at the bottom of the screen to select the mailbox to
which you want to send the message, then press the Copy Message To: button. Your “copy to” intro mes-
sage will automatically be added to the beginning of all copied messages, so you should record something
like, “This message was forwarded from <your name>’s mailbox.” You can record and re-record your “copy
to” intro message as many times as you want, so theoretically it can be tailored for each user as each mes-
sage is sent.

1. The amount of time you are allowed for messages in your mailbox is set by your system administrator.
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In the current version of the software, copying a voice mail message to another mail box using TelOper will
not trigger email notification for the destination mail box.

Note When recording your Copy to: Intro or your Greeting, you can terminate the recording by hitting any
key on the keypad, or by simply hanging up.

The check-boxes at the bottom of this screen allow you to select whether to playback of messages is per-
formed through your computer or through your telephone. Playback through your computer uses the
browser’s built-in audio playback capabilities, so this will only work if your computer and browser are
already able to play audio files.

Alternately, you can play messages over a telephone by clicking the Listen with telephone check-box. The
telephone used will be the one associated with the extension you logged in with.

Normally, the NexPath Telephony Server updates this screen as soon as a new message is completed. If you
think you have a new voice mail message, but it does not appear in the list of messages, click the Reload
button at the bottom of the screen to update the screen contents. Alternately, you can close this window by
clicking on the Close Window button at the bottom of the screen.
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System Information

The button labelled with a key in the Control page is the System Information button. Clicking on it brings
up a window similar to the following:

You can use this window to change your password. Additionally, if your account has been set up with per-
mission to change the system from Day mode to Night mode and vice-versa, you can use the checkboxes in
the center of this page to change the system mode. See Day Ringing/Night Ringing on page 24 in the chapter
Telephone Operations for details on these modes.

FIGURE 6-6. The System Information page
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If you have system administrative privileges, you can also click on Show System Configuration and get
detailed information on the system’s current configuration, though you will not be able to make any changes
to the system configuration from the window displayed. See the NexPath Telephony Server System Adminis-
tration Guide for more details.

You can use the System Information Page to save your current settings. Click on the button Save Current
Settings and your settings will be saved. The server will pop up a confirmation box if the operation was suc-
cessful.

The following settings are currently saved to the server when the Save Current Settings button is clicked:

• Main Page: Monitor VMB selector box, Name selector box.

• Voice mail page: Voice mail box selector, Listen message radio button, Copy Message To selector box.

• Phonebook page: Name/number selector box.
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Using the Phone Book page

When you click on the Phone Book button, a page similar to that shown below will appear:

This pull-down list at the top of this page can be used to select a phone number from either the system-wide
phone book (which you cannot alter), or your personal phonebook (which you can alter).

The system-wide phone book is handy in that you can select an entry from the list, then either dial that num-
ber by pressing Dial button or use the entry as the starting point for creating a new entry of your own.

FIGURE 6-7. A sample Phone Book page
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To create an entry in your personal phonebook, fill in at least the Name and Number entry forms and then
click on Add/Update1. Your entry will be added to your pull-down list. Note that you can enter values in the
Number field either from your keyboard or by clicking on the numbers displayed on the picture of a touch-
tone keypad. Everything but numbers, commas, and the # and * characters will be ignored. The dialer will
convert each comma in an entry into a 1 second delay.

Also, entries which start with a 9 will cause an outside line to be seized, then all numbers after the 9 to be
dialed. To add an entry for 911, for example, you will want to set the number to be dialed to 9,911. The
comma between the nines gives the system time to seize the outside line.

Finally, any entry with seven or more digits will be assumed to be for an outside number, and the system will
automatically seize an outside line before dialing. No prefix of 9 is needed in this case, and if one is added, it
will be removed before the number is dialed. Only the first grouping before the first comma is analyzed to
determine if it is an inside or outside call.

For example, to seize the outside line that is associated with extension 203, then dial 555-1234, then wait
four seconds and enter #111, type the following: 203,555-1212,,,,#111. This will work the same
way whether it is in the phonebook, or typed in the Number entry box on the Control page.

To edit an entry in your personal phonebook, select it from the pull-down list, then make your changes and
click on Add/Update again.

Note Entries in the phonebook are arranged by name, so each name must be unique. For example, If you
change the name of the entry for Steve to Steve Sampson, then click on Add/Update, you will have two
entries, one for Steve and one for Steve Sampson. You can remove the extra entry by selecting it from
the pull-down list, then clicking on Delete Entry.

You will receive an error message if you attempt to modify or delete entries from the system-wide phone-
book.

By specifying a Speed number to be associated with an entry, you will create a speed-dial button back on
your Control page. The number you enter in the Speed # box determines the order in the list of buttons that

1. If you use an entry from the system-wide list as a starting point, you will need to change at least the Name
field before you will be able to save any modifications.
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the entry will be located. A one places the speed button at the top, larger numbers place it towards the bot-
tom. To remove a speed-dial button from your Control page, select the entry associated with the speed-dial
button as it appears in the phonebook, remove the speed dial number from it, then click on Add/Update.

It is possible that, over time, you may generate a long list of entries in your personal phonebook. If so, you
can make a copy of your personal phonebook to your computer by clicking on Save PB Local.

By applying a normal text editor to the file you saved, you can see that the personal phonebook file is a pipe-
separated list, where “|” is the pipe character. You can edit or otherwise revise your personal phonebook file
(perhaps by dumping the contents of an existing contact manager program such as Act! into the file), and
then copy the modified phonebook file back to the NexPath Telephony Server computer by using the
Upload PB button. The File Name fill-in form and the Browse button can be used to select the personal
phonebook file to be uploaded.

The View Log button

Another NexPath Telephony Server feature you can access only from a Web page is a review of all calls
made to and from your phone, including the time and date of each call, either the number you dialed or who
the call was from, and the duration of each call.
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To bring up this information, click on View Log in the Control page. This will bring up a Web page with a
format similar to the following sample page:

The call log feature uses three 1 Mbyte files in a round-robin fashion. When CallLogA gets full, the program
starts filling CallLogB. When that gets full, information goes in CallLogC. When that gets full, CallLogA is
wiped out and restarted. You can use the pull-down list in the upper left corner of this window to select
between the logs available. The system automatically selects the latest call log when you open the screen.

The filters can be used to reduce the amount of information shown in the call log. When these fields are
blank, all calls in the currently-selected call log are displayed. By entering either whole phone numbers or
substrings of numbers, you can reduce the display to just the information in which you are interested. For
example, to show only calls made from 752 to anywhere, set the filters to

From filter: 752

To filter: (blank)

then click on the Reload Log button.

To enter more than one telephone number or substring in a field, separate the numbers with the “pipe” char-
acter “|”. For example, to show all calls made from extension 743 to either extension 120 or 152, type in

FIGURE 6-8. A sample Call Log page
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From filter: 743

To filter: 120 | 152

then click on the Reload Log button.

By default, the filters used on the call log are ANDed; that is, only entries which contain the information
specified by both the filters simultaneously are shown. You can OR the two filters together, however, by
adding the word “OR” anywhere in your “To filter” entry. For example, to list all calls made either to or
from extension 743, type in

From filter: 743

To filter: OR 743

then click on the Reload Log button.

The From Date and To Date set the inclusive range of dates from which the log records are selected. Dates
can be ‘Dec 4’ or ‘Jan 5’, or in the form ‘12/29’ or ‘11/30’. The keyword today is recognized as the current
day as determined by the NexPath Telephony Server.

A single entry such as ‘Dec’ or ‘12’ is assumed to be ‘12/1’ or ‘Dec 1’ in the From Date field, and ‘Dec 31’
or ‘12/31’ in the To Date field. If the entire From Date field is left blank, then it is interpreted as the begin-
ning of the file. If the To Date field is left blank, it defaults to today.

Unless you log in as the system administrator, you can only view calls made to and from your normal (pri-
mary) extension number.

You can copy the information currently being viewed from your call log to a local computer by clicking on
Save Local Copy. A pipe-separated text file (“|” is the pipe character) will be saved which can then be
imported directly into Microsoft Excel or Microsoft Word. The field format can be determined with a
header row which is written as the first line in the file.

The Close Window button allows you to exit the View Log window altogether.
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The status information at the bottom of the Control page

At the bottom of the Control page are three columns of check-boxes and four status indicators showing your
extension’s current status.

The check-boxes in the leftmost column can be used to set your extension to the Accepting Calls mode or
the Do Not Disturb mode. See Accept Calls/Do Not Disturb on page 14 in the chapter Telephone Operations
for details on these two modes of operation.

The check-boxes in the middle column can be used to enable or disable call-waiting for your extension. See
Call Waiting on page 20 in the chapter Telephone Operations for details on call-waiting.

The rightmost column of check-boxes at the bottom of the control page can be used to enable or disable call-
forwarding. The text box next to check-box labelled Forward calls to allows you to enter a number (either
an extension or offsite number) to which to forward calls. If the number is seven digits or more, an outside
line is seized. Long distance numbers must be preceeded by a ‘1’.

Note You can only select one of the two check-boxes in any one column at a time.

Along the bottom of the page are four status indicators: Call on Hold, Conference, Cons. Transfer, and
Voice Mail.

When you have a call on hold, the Call on Hold indicator will turn red and blink. Note that you can use the
From Hold button to retrieve the call.

The Conference indicator will turn blue and blink when you initialize a conference circuit, and will remain
blue until you leave the conference.

The Cons. Transfer indicator will turn green and blink when you initialize a transfer with consultation, and
will remain green until the call is successfully transferred or returned to you.

Finally, the Voice Mail button will turn red and blink when you have unread voice mail in your voice mail-
box.
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CHAPTER 7 Installing the NexPath TAPI 2.1
Service Provider
NexPath provides a TAPI service provider for installation on Win98/ME/2000/XP systems, as a general dial-
ing interface to Windows programs written to the TAPI standard. Examples of compatible programs are the
Microsoft Dialer, Outlook, and some versions of ACT! and Goldmine.

Installing the NexPath TAPI 2.1 Telephony Service Provider (TSP) program

Before installing the NexPath TSP, make sure that your network in operational and that you can contact the
NexPath Telephony Server from your Windows PC via TCP/IP using the ping program or other method.
See the chapter Network Installation starting on page 21 of the System Administrators Manual, or contact
your system administrator for details on establishing a network connection to the NexPath Telephony
Server.

1. If you have a previous version of NexPath TAPI installed, uninstall it first. See “Uninstalling the Nex-
Path TAPI Telephony Service Provider (TSP)” on page 140 for directions on uninstalling a previous
version of the NexPath TSP.

2. Insert the NexPath Telephony Server Release 7 CD-ROM in the Win98/ME/2000/XP Workstation sys-
tem from which you want to run the TAPI compatible programs.

3. Then install the NexPath TSP as follows. Click on Start, then Run, then Browse and select the file
setup.exe in the Release 7\NexpathTapi21 subdirectory of the Release 7 CD-ROM. Follow the prompts
to install the program on your system.
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4. After the NexPath TSP is installed, you need to add it to the recognized service providers. Click on
Start, then Settings, then Control Panel to bring up the Control Panel file viewer.

5. Locate the Telephony (or Phone and Modem) icon in the control panel and click on it, then select File
-> Open to bring up the Dialing Properties dialog box.

6. Click on the Telephony Drivers (or Advanced) tab, and the NexPath TSP32 should be visible as
below:

FIGURE 7-1. Telephony Dialing Properties Window
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7. Click on NexPath TSP32 to highlight it, then click on Configure (or Add). The NexPath Configuration
window should appear as shown below:.

FIGURE 7-2. The NexPath TAPI 2.1 Configuration Window
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8. Fill in your system name (or IP address). (If you are using a system name, it must be in the hosts file or
published in DNS for it to work. See Using your System Name rather than the IP Address on page 29
in the chapter Network Installation or the System Administration Manual for details. Then click on
Add Line, click on the text area Line Name, and type in a descriptive text name, such as Ext. 301, for
your line (delete the NewLine text unless you want this to be your line name).

Note Take care to enter the information correctly in the NexPath configuration window. Errors (such as
invalid extensions or passwords) can cause the Windows TAPI Server to repeatedly crash, making it
very difficult to recover.

Note The NexPath TSP can only be configured to connect to a single NexPath Telephony Server. However,
it can be configured to support multiple extensions on a given NexPath system.

9. Then click on Add Ext, and click in the text area Extension Properties, delete the 0, and type in your
extension number, such as 301.

10. Click on the Password text box, and type in a valid NexPath system password, such as the default for
mailbox 501: 1001.

11. Click on the checkbox for ACT! if you are using ACT!.

12. Carefully check your settings and click on OK at the top and then Close to close the Dialing Properties
window.

13. If any settings are incorrect, or there is a problem with the network, there may be a long delay (60 sec-
onds or more), and you will get a network or NexPath TSP error. The NexPath TSP contacts the Nex-
Path Telephony Server via the LAN, so the LAN-TCP/IP interface must be functional for the TSP to
function.

14. Installation is now complete. You are now ready to use Microsoft TAPI programs for dialing numbers.

Note If you get a dialog window stating that the NexPath TSP is already installed, yet it does not appear in the
list of providers, then a previous installation failed and a registry entry needs to be removed. Using the
registry editor (regedit from a Command Prompt window), delete the registry key “NexPath
TSP32” under HKEY_LOCAL_MACHINE->SOFTWARE->Nexpath, and try to Add the provider
again. Be very careful with the registry editor; if you delete or modify the incorrect registry entry, you
can render you computer unuseable.
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Using the NexPath Telephony Service Provider (TSP) with other programs

Programs such as the Microsoft Dialer (Programs -> Accessories -> Phone Dialer on Win98/ME, and Pro-
grams -> Accessories -> Communications -> Phone Dialer on Win2000/XP), Outlook, Goldmine, and
ACT! are TAPI compliant, so they allow calls to be dialed using these applications with the NexPath TSP
installed. You should consult the documentation for these programs on how to select the address and line to
work with the NexPath Telephony Server.

For example, when you are running the Microsoft Phone Dialer, click on Tools -> Connect Using... to bring
up the Connect Using dialog box. Select the line and extension in the Line and Address selector boxes,
respectively, that you configured above in the installation process, to configure the MS Phone Dialer to dial
using the NexPath system. The display should appear as below:

Note that numbers are dialed with the telephone ON HOOK, for TAPI calls. This is different than calls
placed with NexDial, which are done off hook. The telephone extension that you configured for TAPI will
ring when the call is placed.

FIGURE 7-3. Configuring the Microsoft Phone Dialer to use the NexPath Telephony Server TAPI
interface.
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For outside calls, the call that is placed will roll over to voice mail (if voice mail is configured for this exten-
sion) if the calling extension is not picked-up within the time-out time (usually 20 seconds).

For inside calls, the call will be disconnected if the calling extension is not picked-up within 10 seconds.

Note The Microsoft TAPI interface only supports ON HOOK dialing. It will not dial the telephone with the
extension off hook. Also, your Dialing Rules should not be setup to dial a “9” to seize an outside line;
the TAPI driver does this automatically.

Uninstalling the NexPath TAPI Telephony Service Provider (TSP)

To uninstall any version of the NexPath TSP, do the following:

1. Click on Start -> Settings -> Control Panel to bring up the Control Panel file viewer.

2. Click on Add/Remove Programs, then Select File -> Open (or double click) to bring up the Add/
Remove Program Properties window.

3. Click on the Install/Uninstall tab, then locate NexPath TSP32 in the browser window, and click on
Add/Remove. Follow the prompts to remove the NexPath TSP32 program.

4. Next, remove the NexPath TSP from the service providers by opening the Telephony icon in the Con-
trol Panel as described in Item 5-6 in the installation procedure above.

5. Click on NexPath TSP32 and then click on the Remove button. Click Yes at the prompt to remove it
from the recognized service providers.

6. Next, using the Windows File Explorer, locate the Windows\System subdirectory, and delete the file
NexPathxx.tsp, where xx may or may not be present, or may be numbers such as 16 or 32. On Windows
2000/XP, this file is located in the directory WinNT\System32\.

7. Reboot your PC.

8. The NexPath TSP is now completely removed.
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CHAPTER 8 Frequently asked questions
Question: How do I put a caller on hold?

Answer: During your conversation, enter the Put Call on Hold sequence . The caller will be
put on hold, and you will get an inside dial tone. You can hang up, call another party, what-
ever...

To retrieve the call from hold, pick up your phone or otherwise get an inside dial tone, then use
the Retrieve Call from Hold sequence .

Question: How do I transfer a call?

Answer: You can:

• Do a blind transfer using , then enter the extension number to which you wish to
transfer the call.

• Do a transfer with consultation by entering the Set Up Transfer sequence , which
will put your caller on hold and give you an inside dial tone. At this point, dial the party you
plan on transferring the call to and tell them that a call is coming, then complete the transfer
using the Complete Transfer sequence . Note that if you can’t reach the second
party, or they don’t want the call, you can retrieve the original caller by getting an inside
line dial tone and using the Retrieve from Hold sequence .

Flash 1
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• You can put the caller in a park orbit using a the Blind Transfer sequence , then
transferring them to a park orbit (100, for example). You can then page the person you want
to have pick up the call by dialing the Paging extension 111 and announcing that so-and-so
has a call on 100. The other person just has to pick up any phone and dial 100 to pick up the
caller from the park orbit.

Question: Sometimes I’m in another person’s office when I hear my phone ring. How can I avoid
having to run to my office to catch the call?

Answer: Pick up the phone closest to you and enter the Pick Up Ring Group 0 sequence .

Question: Late at night, I sometimes hear the phone ringing over our PA system. What is this, and
how to I pick up the call?

Answer: When your system is set to “night ringing”, incoming calls may be set to ring over the PA sys-
tem so that anyone left in the building will hear it and be given the chance to answer. To pick
up these calls, enter the Pick Up Ring Group 1 sequence .

Question: My phone occasionally rings with a short ring, but when I pick it up, no one is there.

Answer: You have a call waiting on hold or stuck in a park orbit. You can retrieve it by getting an inside
dialtone at the phone which is giving the short rings and using the Retrieve From Hold
sequence , or dialing the park orbit number, such as 100.

Question: I put a caller on hold, then started another conversation and accidentally put the second
caller on hold also. How do I get back to the first caller?

Answer: You have to pick up your second caller from hold using , then either use the Swap Hold
sequence to put the second caller on hold and retrieve the first caller, or finish your
call with the second caller, hang up (or disconnect using ), then pick up and retrieve
the first call from hold using .
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Question: When people call my extension, my phone doesn’t ring. Instead, their calls go to my voice
mail. When I call them back, they say they heard my phone ring, but I didn’t pick up.
What’s going on?

Answer: If your phone is equipped with a switch to turn the ringer on and off, check it and make sure
that the ringer is turned on.

Answer: If the ringer is on but the phone still won’t ring, you may have your extension in the Do Not
Disturb mode. Change the mode to Accept Calls as described on page 14.

Question: Sometimes, when I’m in the middle of a conversation, I hear two beeps. What does this
mean?

Answer: This is the call-waiting indicator, meaning that another caller is calling. You can put your exist-
ing call on hold and pick up the new call, or let the new call go to voice mail.

By the way, one beep would be a reminder that you have another call on hold, and three beeps
would indicate that someone else has barged into your conversation by using the Barge In
sequence .

Question: When I pick up my phone, I hear a beep-beep-beep tone then a steady dial tone. What
does this mean?

Answer: This is known as a stutter dial tone. It indicates that you have new messages in your voice
mailbox You can have more than one voice mail box causing a stutter dial tone on you exten-
sion. See the next question for details.

Question: When I pick up my phone, I get a beep-beep-beep tone instead of a steady dial tone, but
when I access my voice mailbox, there are no new messages.

Answer: The phone you are picking up may have more than one extension associated with it, and the
new message or messages indicated by the stutter dial tone may be for one of these other exten-
sions. Use the Announce Line and Extension Numbers sequence to determine the physi-
cal line number and all extension numbers associated with the telephone being used, then try
accessing the voice mailboxes of any other extensions mentioned. For example, in the default
configuration, Ext. 303 has both mailboxes 503 and 599 that cause stutter dial tones on its line.

# 2

# 8
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Question: Do I have to be at my computer to use the computer interface programs?

Answer: For dialing functions, you have to be able to lift the receiver. But you can control any phone if
you have proper permissions. You can access the Web browser page, or NexDial or NexDirec-
tor, from any computer on your network, but will still need to log in using your usual exten-
sion number and password. Also, unless you have system administration privileges, none of
the operations that require a phone, such as listening to your voice mail over the phone or using
your speed-dialer to dial a number, will be accessible from any other phone but the one on your
desk.

Question: What do I do when I can’t dial “out” from the Web browser?

Answer: First, make sure you have a 9 at the beginning of your number, then a 1 before the area code if
one is present. If these are both present, then it’s possible that your problem is that you are not
successfully seizing an outside line.

The 9 at the beginning of your number causes the NexPath Telephony Server to seize an out-
side line, wait one second, the dial the remaining digits. If the system is running slow (perhaps
a lot of people are making conference calls), then it may take more than one second to seize an
outside line. Try adding one or two commas after the 9 at the beginning of the number (each
comma creates an additional one second delay).

Question: I cannot get my web browser to properly log into the NexPath Telephony Server. What
could be wrong?

Answer: First, make sure you are using Netscape 3.03 or later or Communicator 4.04 or later browser
version. If you do not have DNS, you must enter the system name in the Windows HOSTS file
(see next paragraph, or your system administrator), or you must use the IP address instead.
JavaScript and cookies must be enabled in the browser. To be sure you have a good network
connection, try pinging the NexPath Telephony Server. This can be done from a DOS window,
by typing the command ping followed by the system name or IP address. You should get a
response. If you do not, either TCP/IP is not installed correctly, or the network cable is not
properly connected. Remember that the NexPath Telephony Server only uses the 10BaseT net-
work connector (RJ-45 phone jack style connector).

The HOSTS file on Windows 98/ME is located at \Windows\Hosts. On Windows 2000/XP, it
is located at Winnt\system32\drivers\etc\Hosts. Make sure you are not trying to use the
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HOSTS.SAM file, or LMHOSTS. These will not work. The HOSTS file should contain at
least two lines:

127.0.0.1 localhost

111.111.111.111 nexpath

Substitute your IP address for 111.111.111.111 and your NexPath system name for nexpath.

Also see Testing your network connection on page 28 in the chapter Network Installa-
tion of the System Administration Guide.
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APPENDIX A Glossary
Accept Calls mode Individual extensions can be placed in either an “Accept Calls” mode or a “Do
Not Disturb” mode. The “Accept Calls” mode is the normal mode of operation.
In comparison, when an extension is in “Do Not Disturb” mode, calls placed to it
will not ring the phone associated with the extension but instead will be sent
directly to voice mail.

If the extension is part of a call distribution group, incoming calls will be routed
past any extensions which are in the “Do Not Disturb” mode and will go on to
the next extension in the group.

ACD Automated Call Distribution or Automatic Call Distribution. See call distribu-
tion groups below.

auto-attendant An automated call-routing system for incoming calls which can be used either
instead of or in addition to a live operator. The auto-attendant is the system which
tells incoming callers, “Press 1 for Sales, 2 for...”

barge-in Breaking into an existing conversation or picking up a line after a caller has
already started leaving voice mail
147



User’s Guide

user.bk Page 148 Tuesday, September 23, 2003 10:06 AM
call distribution group Groups of extensions can be grouped into a call distribution group. This function
is part of the auto-attendant function, and is normally used to allow callers to dial
an entire department, such as sales, rather than just an individual. When the auto-
attendant routes a call to a call distribution group, the phones associated with all
extensions set to “Accept Calls” in the group will ring in sequence (one at a time)
until either the call is picked up by someone or it times-out. If a call times-out,
depending on how the auto-attendant is configured, the call is either sent to voice
mail or the caller is given a message and disconnected. If at least one of the
extensions in the group is busy, then the call will go into a waiting queue, where
reassurance messages are played, along with hold music if enabled, until either a
time-out is reached or one of the group extensions becomes available.

Note that call distribution groups are not the same as ring groups. See ring
groups for the definition of a ring group.

call forwarding When call forwarding is enabled for an extension, callers dial one extension (for
example, 752) but the call rings and can be answered at another extension (for
example 805). The extension dialed (752) is the “forwarded” extension. The
extension where the call actually rings (805) is the “forwarding” extension. Note
that, in this example, if no one answers at the phone at extension 805, the call
will go to the voice mailbox of extension 752.

call waiting When call waiting is enabled for your extension, you will hear a short beep at
your end of the conversation if you are on the phone and another call comes in.

Note that, when you hear a call-waiting beep, you can simultaneously place your
current call on hold and pick up the incoming call by entering the Pick Up Wait-

ing Call sequence .

You can then toggle between the calls using the Swap Hold sequence

.

Centrex Centrex lines are a type of central office line with special features. Centrex lines
are standard analog loop start lines, but have different capabilities at the central
office. The only Centrex capability that is relevant for the NexPath Telephony
Server is the ability to transfer a call using hook-flash signalling, so that the Nex-
Path Telephony Server can drop out of the call. Centrex lines are sometimes
known by different names in other parts of the US.

Flash 3

Flash *
148



user.bk Page 149 Tuesday, September 23, 2003 10:06 AM
CPC Calling party control, also known as line supervision or wink disconnect signal-
ling. All of these terms refer to the brief interruption in the battery current on an
analog line, to indicate to connected equipment when a distant party has discon-
nected. The CPC signal is required by the NexPath Telephony Server on
inbound CO lines, to prevent calls that are in the auto-attendant or conferenced
with other CO lines, from becoming connected indefinitely even though the out-
side party has hung up. Most if not all central offices in the US provide this sig-
nal, but some channel banks (analog line conversion from T1 digital lines) do
not. NexPath does not recommend connecting the NexPath Telephony Server to
channel bank or ISDN-to-analog equipment that does not provide the CPC sig-
nal.

CPC Delay The CPC delay is the time from when the caller actually has disconnected, to
when the central office sends the CPC signal. The NexPath Telephony Server
has a programmable CPC delay compensation adjustment, to compensate for this
time delay, to eliminate long periods of silence at the end of voice mail messages.
This can be programmed by the system administrator. See the System Adminis-
tration Guide for details. The CPC delay compensation is merely a fixed amount
of time that is chopped off of the end of all voice mail messages. If you find
voice mail messages cut off at the end, the CPC delay compensation factor may
have been set too large. Contact your system administrator.

Day mode Each extension can be assigned to ring at a different phone or group of phones
depending on whether the system is in the Day mode or Night Mode. Usually,
systems are configured so that calls placed to the operator ring at the operator’s
phone when the system is in Day mode, but ring over the overhead PA speaker
when the system is in Night Mode. Individual extensions may be similarly con-
figured. Day and night mode can be changed from the telephone keypad and
from the web application TelOper, as described in the Users Manual.

Do Not Disturb mode Individual extensions can be placed in either an “Accept Calls” mode or a “Do
Not Disturb” mode. When an extension is in “Do Not Disturb” mode, calls
placed to it will not ring the phone but instead will be sent directly to voice mail.

If the extension is part of a call distribution group, incoming calls will be routed
past any extensions which are in the “Do Not Disturb” mode and will go on to
the next extension in the group.

extension number The number an outside caller dials to get to a specific person or department.
Extension numbers are also used to access outside lines, ring groups, PA speak-
ers, voice mail boxes, speed dial numbers, park orbits, and automated attendants.
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FSK Frequency Shift Keying, in this manual referring to the signalling technique for
control the voice mail light on compatible telephones, and the signalling tech-
nique for communicating the caller ID of an inbound call.

hook-flash The hook-flash is used to communicate to the system that some sort of control
sequence will follow. It is accomplished by depressing the telephone hook switch
for an interval of greater than 50 milliseconds and less than 750 milliseconds (a
millisecond is 1/1000ths of a second, so 750 milliseconds is 3/4 of a second).

Some telephones have a flash button that accomplishes this task.

Note that your telephone system distinguishes between a hang-up, which is
longer than about three-quarters of a second, and a hook-flash, which is a short
depression of the hook switch.

The symbol is used in this manual to indicate a hook-flash.

inside lines The physical lines which you will run within your building and connect your
telephones, FAX machines, etc. Also called station lines or inside extension
lines. Designated by the NexPath Telephony Server as IL-1, IL-2, etc.

inside dial tone A dial tone provided by the NexPath Telephony Server rather than by the local
telephone company. Note that, depending on the dial tone provided by your
phone company, the tone of an inside dial tone and an outside dial tone may be
indistinguishable from one another.

listen in Listening into an existing conversation or listening to a line after a caller has
already started leaving voice mail (screening voice mail).

Night mode Each extension can be assigned to ring at a specific phone or group of phones
depending on whether the system is in the Day mode or Night Mode. Usually,
systems are configured so that calls placed to the operator ring at the operator’s
phone when the system is in Day mode, but ring over the overhead PA speaker
when the system is in Night Mode. Individual extensions may be similarly con-
figured. Day and night mode can be changed from the telephone keypad and
from the web application TelOper, as described in the Users Manual.

outside dial tone A dial tone the local telephone company. Note that, depending on the dial tone
provided by your phone company, the tone of an inside dial tone and an outside
dial tone may be indistinguishable from one another.

outside lines Sometimes called CO, for Central Office, lines, trunk lines, or telco lines. All
of these terms are synonymous, and refer to the physical lines which come into
your building from the phone company.

park orbit A special way of putting a call on hold which allows anyone to pick the call up
by dialing the number of the park orbit (a type of public hold).

Flash
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password protection To insure that unauthorized people do not retrieve your voice mail, barge into
your conversations, etc., many of the advanced features of the NexPath Tele-
phony Server require that you enter a numerical password to identify yourself to
the system before the feature can be accessed.

physical lines The actual telephone lines connected to the NexPath Telephony Server.

pickup groups See ring groups below.

ring cadence Extensions can be programmed to ring with any of six different ringing patterns,
or cadences. Extensions can also be programmed to ring differently depending
on whether the call is an inside call or a call from an outside line.

ring groups Groups of physical telephone lines can be assigned to a ring group, also called a
pickup group. This function is normally used so that a ringing phone can be
picked up from another (non-ringing) phone using the pick up group sequence

, followed by a single digit ring group number.

An extension can also be assigned to a ring group, so that when the extension is
dialed, the group of phones will ring. The first extension picked up in the group
of ringing phones will get the call.

Note that ring groups are not the same as call distribution groups. See call distri-
bution group above for the definition of a call distribution group.

Short Name This is the name that is recorded in a voice mai box, so that when a voice mail
message is copied to another mail box, this name recording is prepended to the
message to identify who it is from. Also, the short name is used to identify all
extensions that forward to the voice mail box where it is recorded, to identify the
extensions in the dial by name auto-attendant.

system administrator This is the person in charge of administering the system, that is, adding or remov-
ing users, assigning users extension numbers and passwords, and changing other
system parameters as needed. Please refer to the NexPath Telephony Server Sys-
tem Administration Guide for more details on what the system administrator can
and cannot do.

* 0
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user In this manual, the term “user” is used to describe someone who has been
assigned an account on the system by the system administrator (i.e., someone
who has been assigned a password, an extension number, a voice mailbox, etc.).
A particular user is identified by the system via his secret password.

VMWI Visual Mail Waiting Indicator, the light on compatible telephones that indicates if
there is unread voice mail. The VMWI standard for voice mail lights is also
called the FSK technique (see the FSK definition in this glossary), and refers to a
signalling technique for controlling the voice mail light with low speed modem-
like tones. Telephones that are caller ID compatible, that have a voice mail indi-
cator, are almost universally VMWI compatible, since both signalling techniques
are in the same Bellcore standard.
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A
Accept Calls mode

defined 147
enabling from a telephone 14
enabling from NexDial 78
enabling from the desktop web interface

(TelOper) 133
accessing voice mail

from an inside line 52
from an outside line 58
from NexDial 82
from the web interface (TelOper) 117

ACD
defined 147

adding a voice mail distribution group 61
adding entries to the desktop web interface phone

book (TelOper) 129
adding to a conference call

from a telephone 23, 47
from NexDial 77
from the web interface 119

announce line and extension numbers over a
telephone 34

audio player
selecting from NexDial 80
auto-attendant, defined 147
automated call distribution (ACD)

defined 148

B
bandwidth of system 2
barge-in

defined 147
performed from a telephone 16
performed from the web interface 119
performing voice mail barge in from

NexDial 77
performing voice mail barge-in from the web

interface (TelOper) 117
beeps, described 9
blind transfers

performing from a telephone 46
performing from NexDial 74
performing from the web interface 118

C
call control

from the desktop using NexDial 76
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from the web interface (TelOper) 118
call distribution groups

defined 148
detailed description 11

call forwarding
defined 148
enabling from a telephone 17
enabling from NexDial 78
enabling from the desktop web interface

(TelOper) 133
call waiting

defined 148
enabling from a telephone 20
enabling from NexDial 78
enabling from the desktop web interface

(TelOper) 133
cancel call forwarding

from a telephone 19
from NexDial 78
from the web interface (TelOper) 133

Centrex
defined 148

change numeric pager number
from NexDial 88
from the telephone 59
from the web interface (TelOper) 122

changing a password
from NexDial 80
from the web interface (TelOper) 126
over a telephone 42

channel banks
connecting to the NexPath Telephony

Server 149
clearing a command sequence when using a

telephone 22
CO lines

defined 150
completing a consultation transfer

from NexDial 77
completing a transfer

from a telephone 47
154
from the web interface (TelOper) 118
conference call

setting up from a telephone 23
setting up from NexDial 77
setting up from the web interface

(TelOper) 118
consultation transfer

from a telephone 46
from NexDial 77
from the web interface (TelOper) 118

Control page, typical (TelOper) 116
controlling your phone from a web browser 113
copy to intro

use with web interface 124
copying a voice mail message

to a local computer using NexDial 83
to a local computer using the web

interface 124
CPC

defined 149
CPC delay

defined 149
current system configuration, displaying with the

web interface (TelOper) 126

D
Day mode

defined 149
enabling from a telephone 24
enabling from NexDial 80
enabling from the web interface (TelOper) 126

delete numeric pager number
from NexDial 88
from the telephone 59
from the web interface (TelOper) 122

deleting a voice mail message
from NexDial 85
from the web interface (TelOper) 124

deleting an entry from the TelOper phone book
(web interface) 129
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determining if you have new voice mail messages
from your telephone 51

dial by name
recording your name announcement 60

dialing a number
from NexDial 74
from the web interface (TelOper) 118

dialing a number from the computer-based phone
book in the web interface (TelOper) 128

dialing a voice mail call back number
from NexDial 83
from the telephone keypad 56

direct transfers
performing from a telephone 46
performing from NexDial 74
performing from NexDirector 109
performing from the web interface 118

disable numeric paging 59
disabling call waiting

from a telephone 21
from NexDial 78
from the desktop web interface (TelOper) 133

disconnecting from a call without hanging up
from a telephone 26
from NexDial 76
from NexDirector 111

Do Not Disturb mode
defined 149
enabling from a telephone 14
enabling from NexDial 78
enabling from NexDirector 111
enabling from the desktop web interface

(TelOper) 133

E
email

setup notification of new voice mail
from NexDial 89
from web interface (TelOper) 123

entering a password when using a telephone 42
extension numbers
announcing over a telephone 34
defined 149

F
forward calls

enabling from a telephone 17
enabling from NexDial 78
enabling from the desktop web interface

(TelOper) 133
forwarding a voice mail message

to a group using NexDial 84
to a group using the keypad, to another mail

box using the keypad 55
to another mail box using NexDial 84
to another mail box using the telephone

keypad 55
to another mail box using the web

interface 124
FSK

defined 150

G
greeting

listen to your voice mail greeting 57
recording using a telephone 57
recording using NexDial 84
recording using the web interface 124
setting the standard or alternate greeting

from NexDial 85
from the telephone 57

groups
creating and using voice mail distribution

groups (NexDial) 90

H
help

announcing the command sequences over a
telephone 28

announcing the use of the telephone keypad
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when in voice mail 56
hold

performing hold operations from NexDial 76
performing hold operations from

NexDirector 110
performing hold operations from the web

interface (TelOper) 117
placing a call on hold from a telephone 29
retrieving a call using a telephone 29
swapping hold

from the web interface 117
on a telephone 30

hook-flash
defined 150
detailed description 8
sending to a CO line 31

I
initiating a conference

from a telephone 23
from NexDial 77
from the web interface 119

inside dial tone
defined 150

inside lines
defined 150
detailed description 32

L
line numbers, announcing over a telephone 34
listen

listen to your voice mail greeting 57
listen in

defined 150
performed from a telephone 35
screening voice mail from NexDial 77

logs
viewing the call log from Windows programs

(NexDial) 94
viewing the call logs from the desktop web
156
interface (TelOper) 130

M
mailbox full 58

N
NexDial

Windows desktop call control application 67
NexDirector

call director program (NexDir) 97
Night mode

defined 150
enabling from a telephone 24
enabling from NexDial 80
enabling from the web interface (TelOper) 126

numeric pager
setting up from the telephone 59
setting up notification of new voice mail from

NexDial 87
setting up notification of new voice mail from

the web interface (TelOper) 122

O
one beep or ring 9
on-off-on dial tone 51
operator

dialing from the voice mail greeting 64
dialing the operator from a telephone 37

outside dial tone
defined 150

outside lines
defined 150
detailed description 38

P
PA system

making announcements through the 39
picking up calls ringing over the 12

page upon receiving voice mail
setting up from NexDial 87
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setting up from the telephone 59
setting up from the web interface

(TelOper) 122
pager

setup numeric pager notification of new voice
mail

from the telephone 59
from web interface (TelOper) 122

paging (public address) from a telephone 39
park orbit

defined 150
detailed description 40
retrieve a call using NexDial 74
retrieve a call using NexDirector 110
retrieve a call using the telephone 40

passwords
changing from NexDial 80
changing using the telephone 42
defined 151
detailed description 42

phone book
maintaining with Windows program

(NexDial) 92
page on the desktop web interface

(TelOper) 128
physical lines

defined 151
picking up a ring group

from a telephone 44
from NexDial 76
from the web interface (TelOper) 119

Picking up a ringing call
from NexDirector 110

picking up a waiting call
from a telephone 20
from NexDial 77
from the web interface (TelOper) 119

pickup groups
defined 151

placing a call on hold
from a telephone 29
from NexDial 76
from NexDirector 110
from the web interface (TelOper) 116

playing back
your mail box greeting from NexDial 85
your mailbox greeting over a telephone 57
your mailbox greeting using the web

interface 124

R
Record a call

from NexDial 81
from the telephone keypad 45
voice mailbox where recording is saved 71

record a greeting
using a telephone 57
using NexDial 84
using the web interface 124

recording a copy to intro
from web interface (TelOper) 124

recording your short name 60
removing a voice mail distribution group 61
retrieve a call from a park orbit

using NexDial 74
using NexDirector 110
using the telephone 40

retrieving a call from hold
from a telephone 29
from the web interface (TelOper) 117
using NexDial 76
using NexDirector 110

ring cadence
defined 151
detailed description 11

ring groups
defined 151
detailed description 11
picking up from NexDial 76
picking up using a telephone 44
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picking up using the web interface
(TelOper) 119

rings 9

S
screening voice mail

from NexDial 77
from the telephone 35

seizing an outside line
from NexDial 74
from NexDirector 110
from the telephone 38

sending a call to voice mail
from NexDial 78
from the web interface (TelOper) 117

sending a message directly from voice mail 62
setting up a conference call

from a telephone 23
from NexDial 77
from the web interface (TelOper) 118

setting up consultation transfers
from a telephone 46
from NexDial 77
from the web interface (TelOper) 118

short name
defined 151

speed dial
using buttons in NexDial 75

speed dial buttons
on the desktop web interface (TelOper), adding

and deleting 129
stutter dial tone 51
summary of the keypad sequences used with a

telephone for call control 48
swapping between a current call and a call on

hold
from a telephone 20, 30
from NexDial 76
from the web interface 117

system administrator, defined 151
158
system configuration, displaying via the web
interface (TelOper) 126

T
TAPI

Installing the NexPath TAPI TSP 135
NexPath TAPI Interface 135
Uninstalling the NexPath TAPI TSP 140
Using the NexPath TSP with other

programs 139
telco lines

defined 150
telephone keypad when in voice mail

(diagram) 53
three beeps 10
time and date announcement

setting from NexDial 86
setting from web interface (TelOper) 122

tranferring calls
from NexDirector 109

transferring calls
from a telephone 46
from NexDial 74
using the web interface (TelOper) 118

transferring calls with consultation
from a telephone 46
from NexDial 77
from the web interface (TelOper) 118

trunk lines
defined 150

two beeps 10

U
URL of browser-based call control program

(TelOper) 114
user, defined 152

V
viewing the call logs from the desktop web

interface (TelOper) 131
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VMWI
defined 152

voice mail
accessing from

NexDial 82
the web interface (TelOper) 117

accessing from an inside line 52
accessing from an outside line 58
adding a distribution group 61
alternate greeting 57
announce time and/or date

setting from NexDial 86
setting from the web interface

(TelOper) 122
creating and using voice mail distribution

groups (NexDial) 90
deleting a message using NexDial 85
deleting a message using the web

interface 124
determining if you have new messages using

your telephone 51
dialing a call back number

from NexDial 83
from the telephone 56

email notification
setup from NexDial 89
setup from web interface (TelOper) 123

features available when leaving a message 64
forwarding messages to a group

from NexDial 84
from the telephone 55

forwarding messages to other mail boxes
from NexDial 84
from the telephone 55
from the web interface (TelOper) 124

help over telephone 56
listen to your greeting from a telephone 57
main menu 54
message menu 53
message sorting order 55
playing back messages from the telephone 54
playing back your greeting using NexDial 85
playing back your greeting using the web

interface 124
press one during record keypad options 63
recording a greeting

from a telephone 57
from NexDial 84
from the web interface 124

recording your short name 60
removing a distribution group 61
replying to a message

from the telephone 56
sending a message directly from voice mail 62
setting the audio player in NexDial 80
setting the standard or alternate greeting

from NexDial 85
from the telephone 57

setting up numeric pager notification
from NexDial 87
from the telephone 59
from the web interface (TelOper) 122

standard greeting 57
use of telephone keypad when in 53

Voice Mail Alert
pop-up on the web browser interface

(TelOper) 120
red indicator on NexDial program 79

voice mailbox full 58
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